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Abstract
This Exam Manual covers all of the knowledge, concepts and procedures you need to master in order to 
take and pass the Configuring Server Virtualization (70-652) exam.  We will discuss every aspect of server 
virtualization, from installing and managing the Hyper-V server role, through SCVMM concepts and into 
more esoteric issues, such as the heartbeat monitor and migrating from physical machines to virtual 
machines.  Successfully passing this exam will earn an MCTS in Configuring Server Virtualization, as well  
as credit towards your MCITP: Virtualization Administrator.

What to Know
•	 Know how to install Hyper-V and perform basic configuration
•	 Know the basic structure of the hypervisor
•	 Understand the differences between planned and unplanned downtime
•	 Understand the differences between Quick Migration vs. Live Migration
•	 How to setup a cluster
•	 Understand the different controls available (Action Pane, Pause, Save State)
•	 Hyper-V configuration steps 
•	 Understand remote administration
•	 Create a virtual machine
•	 Virtual network types
•	 Remote connectivity
•	 Remote administration
•	 Domain vs. non-domain
•	 Remote desktop protocol (RDP)
•	 Navigating the Hyper-V Console
•	 Know how to create snapshots, the purpose of snapshots
•	 Security considerations
•	 Setting Permissions
•	 Storage considerations
•	 Integration services
•	 Hyper-V Network Types
•	 Install and Configure Management Tools
•	 Server Core Installation of Hyper-V Role
•	 Configuration of Windows Vista SP1Server Settings
•	 VMI Interaction
•	 Virtual Networks
•	 Active Directory Domain Service
•	 Remote Connections
•	 Virtual Hard Drives
•	 Disk Types
•	 Configure High Availability Virtual Machine
•	 Resource Allocations
•	 Converting – Physical Machines, Virtual Machines, VMware
•	 VMware VirtualCenter
•	 SCVMM Self Service Portal
•	 SQL Server Database Considerations
•	 Conversions: P2V, V2V, online, offline
•	 Reporting mechanism
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Tips
The 70-652 exam will test your knowledge from both a factual and process-oriented standpoint. 
Therefore, it is important not only to remember facts (such as the different kinds of VHD files, or what 
the CPU requirements for Hyper-V are), but also how to perform tasks in both the Hyper-V manager and 
SCVMM. Although SCVMM is a separate exam, 70-652 expects you to be able to perform and verify the 
results of common tasks related to VM management. An example of this would be adding an item to a 
library share on an SCVMM host.

Therefore, not only should you study the content in this Exam Manual, but you should practice these 
concepts on a personal lab. A lab computer should meet the requirements of running Hyper-V, and have 
at least 2 gigabytes of RAM for concurrently-running virtual machines. SCVMM can run on the lab server 
or it can be virtualized. Since Hyper-V cannot run inside a virtual machine, at least one physical server 
is required.

For your lab, you do not need to activate Server 2008 or any of the guest operation systems. Server 2008 
will be fully functional without activation long enough to at least study for the 70-652 exam.

If you want to run the standalone Hyper-V product from Microsoft that should be fine for the exam, 
but you will need another PC to manage the Hyper-V server. 

The standalone edition of Hyper-V can be downloaded free from Microsoft. SCVMM is available as a free 
trial download that will work without purchase for 365 days. Microsoft has also released a trial of SCVMM 
in VHD format for importing to Hyper-V. 

Experimenting with failover clustering in a lab can be more complicated. Not only will you need a second 
Hyper-V server with the same architecture, you will also need a shared storage SAN such as Fibre Channel 
and or iSCSI, and multiple network cards. We recommend studying clustering from a textbook perspective 
and understanding the concepts, rather than actually building a failover cluster for your lab.

Finally, the 70-652 exam covers Windows Server 2008 R1 and SCVMM R1. This is the first version of 
Windows Server 2008 with or without Service Packs. The 70-659 exam covers Windows Server 2008 R2, 
which adds performance and reliability features to Hyper-V, and SCVMM R2. At the time of this writing, 
Microsoft has made it difficult to download R1 versions of the software. From a Hyper-V perspective, 
R2 mainly provides additional features. While there shouldn’t be any issues with studying for 70-652 
using R2, there may be some minor inconsistencies.
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Domain 1: Introducing Windows Server 2008 Hyper-V
Understanding Virtualization
Hardware virtualization enables multiple OS instances to run simultaneously on a single physical host 
computer. Each guest OS instance runs in a Virtual Machine (VM) that mirrors a complete computer in 
software, including the processor, memory, graphics card, network interface, and storage devices (such as 
disk and CD-ROM drives). The hardware is shared with other OS instances. 

Virtualization consolidates many servers to a single system to provide lower total cost of ownership (TCO), 
and increased optimization. Virtualization also increases environment flexibility and integrates 32-bit 
and 64-bit workloads in the same environment. Virtualization is beneficial when current chip technology 
exceeds utilization. The server operating system is separate from the hardware, allowing many servers to 
run on one machine as a virtual machine.

Hyper-V Basics
Hyper-V is installed as a role in Server 2008 to take advantage of 64-bit, hardware-assisted virtualization 
technology. It uses a hypervisor to manage virtual machines. Each virtual machine is given a portion of 
memory and processing power (up to 4 virtual processors) and 64 GB of RAM.

Hyper-V uses partitions that include a parent (or root) partition that runs either a full installation of 
Windows Server 2008 or a Server Core installation, which is a minimal environment for running specific 
server roles. The virtualization stack, a collection of software components that work together to support 
the virtual machines, runs in this parent partition and has direct access to the hardware devices. 
From the root partition, child partitions can be created. Child partitions can run different operating 
systems, including hypervisor-aware operating systems and older operating systems that do not have 
direct access to the hardware resources. Their requests are redirected through the parent partition via a 
virtual machine bus (VMBus), a subsystem for exchanging requests and data.

Figure 1: Basic Hypervisor Structure

Hyper-V Benefits
Hyper-V provides a scalable, reliable, and highly available virtualized server computing environment. 
Hyper-V enables one or more guest operating systems to run concurrently on a single physical computer. 
Virtual machine uses include:

•	 An agile environment that allows rapid deployment 

•	 Ability to develop and test easily 

•	 Server Consolidation

•	 Consolidation of development and testing environments

http://www.preplogic.com/products/video/view-video-training.aspx


Exam Manual  n  Configuring Windows Server Virtualization (70-652)                                                                     1-800-418-6789

LearnSmart                                                               Cloud Classroom:  Video Training  n   Practice Exams  n  Audiobooks  n  Exam Manuals

•	 Simplified disaster recovery

•	 Quick migration, live migration and VM Failover capabilities to increase business continuity 
(minimize both scheduled and unscheduled downtime)

•	 Creates a dynamic datacenter with features such as:

�� Automated virtual machine reconfiguration

�� Flexible resource control

�� Quick migration

�� Dynamic IT environment that responds to problems and anticipates  
increased demands

�� VMs run in isolated environment

�� Branch consolidation 

�� Hosts desktop infrastructure

�� Host machine with memory of up to 1 terabyte and up to 64 GB per VM

Hyper-V has built-in licensing for Server 2008 child instances. 

•	 Standard licenses up to 1 VM instance.

•	  Enterprise licenses up to 4 VM instances.

•	  Datacenter includes unlimited VM licenses. 

In other words, by purchasing an edition of Server 2008, you are also purchasing the rights to Server 2008 
virtual machines. However, the free bare-metal hypervisor product, Hyper-V Server, does include any 
licensing benefits.
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Installing Hyper-V
On full versions of Windows Server, Hyper-V can be added as Role from the Server Manager console. 

Figure 2: Installing the Hyper-V Role

The only option you are given when installing the Hyper-V role is what network cards you want to 
use with Hyper-V. Note that in this wizard, Microsoft recommends leaving one network card for host 
management traffic, to keep host traffic out-of-band to guest traffic. This recommendation is discussed 
later in the text.
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Figure 3: Select which network cards to make available to Hyper-V

Installing the Hyper-V role requires a reboot. After reboot, the Hyper-V Role in the Server Manager should 
then show 3 services that are running:

Figure 4: Verifying Hyper-V Services after a successful install

These services are important for your exam and in the real world. The three services are:

•	 The Hyper-V Image Management Service

•	 The Hyper-V Networking Management Service

•	 The Hyper-V Virtual Machine Management Service

Hyper-V is actually a kernel-level part of Server 2008 and is not controlled by any particular service, 
but these three services help provide management to various aspects of Hyper-V guests.

http://www.preplogic.com/products/video/view-video-training.aspx


Exam Manual  n  Configuring Windows Server Virtualization (70-652)                                                                     1-800-418-6789

LearnSmart                                                               Cloud Classroom:  Video Training  n   Practice Exams  n  Audiobooks  n  Exam Manuals

Installing Hyper-V on Server Core
Server Core provides a stripped-down version of Server 2008 with three main benefits as a Hyper-V host:

•	 Fewer services running, providing a smaller attack surface than Full Server 2008

•	 Fewer components to update through Windows Update

•	 More RAM available for the guest operating systems

To install the Hyper-V role on server core, only one command is needed:

start /w ocsetup Microsoft-Hyper-V

This command is case sensitive and must be executed as a local administrator. That being said, there are 
some auxiliary commands that are outside the scope of the 70-652 exam to make Server Core operational. 
Because these tasks are outside the scope of the exam, we will not go in to details here, but the tasks you 
will need to perform for an operational Hyper-V Server Core host include:

•	 Installing Drivers

•	 Setting the system IP address with netsh.exe

•	 Setting the firewall options with netsh.exe

•	 Setting the system name and domain with netdom.exe

•	 Activating windows with the slmgr.vbs script

•	 Enabling remote desktop with scregedit.wsf

•	 Configuring windows updates with scregedit.wsf

•	 Enabling remote management with WinRM

Navigating the Hyper-V Console
After Hyper-V has been installed, the next step is to install guest images that will run on the virtual server. 
Before doing so, below is a quick review on navigating the Hyper-V Administrative console and the virtual 
server guest session settings that are available for configuration.

•	 Launching the Hyper-V Administrative Console – open the Hyper-V Administrative console 
to access the configuration options. Use the Server Manager tool and administer the host server 
through Server Manager, or launch the freestanding Microsoft Management Console (MMC) to 
perform administrative tasks for the host system. 

•	 Using the Server Manager Tool to Manage Hyper-V Systems – use the Server Manager to 
administer Hyper-V systems from a centralized console. The Server Manager tool provides a 
common administrative interface for all of the server roles installed on a particular system.  

Starting the Server Manager: 

1.	 Click Start and then click Run. 

2.	 In the Run dialog box, type in ServerManager.msc, and click OK to start the Server Manager 
application if it is not already running on the system.

3.	 Click on the + to expand the Roles section of the tree.

4.	 Expand the Hyper-V branch of the tree.

5.	 Expand the Virtualization Services branch of the tree. 
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Use the Hyper-V MMC Tool to Manage Hyper-V Systems 
Use the Hyper-V tool to administer Hyper-V systems from a dedicated console. 

Starting the Hyper-V MMC Tool 

1.	 Click Start → All Programs → Administrative Tools

2.	 Choose Hyper-V Management for the tool to launch. 

3.	 Click on Virtualization Services to see the connected virtual servers.

4.	 Click on the name of one of the virtual servers listed to see the virtual machines and actions 
available for the confirmation of the server system. By default, the Hyper-V MMC will have the 
local virtual server system listed.

Connecting to a Different Virtual Server System 
Log on and connect to another serve to administer and manage its virtual server system.

Log on to Virtual Server System:

1.	 In the left pane of the Hyper-V Management Console, click on the  
Virtualization Services option.

2.	 Select Action → Connect to Server.

3.	 Select Another Computer.

a.	 Enter the name of the server.

b.	 Click OK.

c.	 Or click on Browse to search Active Directory for the name of the server that is to be 
remotely monitored and administered.

4.	 When the server appears in the Hyper-V Management Console, click to select the server and the 
actions available for administering and managing that server. 

Navigating and Configuring Host Server Settings
Server Manager and MMC tool configuration options and settings are the same. 

When the Virtualization Settings action item is selected, access to configure default paths and remote 
control keyboard settings becomes available. Settings include:

•	 Default Paths – allows ability to set the location drive path where virtual hard disks and  
snapshots are stored. The default path could be on the server system on a local disk or stored  
on an external SAN. 

•	 Remote Control – remote control settings include how to switch to Local, Remote, or Full Screen 
mode. There is also a remote control setting that allows selecting which keystroke is used to 
release the mouse and keyboard control back to the host when administering a guest session. 

•	 Keyboard Release Key – by default, the key that releases the guest session so the administrator 
can gain keyboard control back to the host console is Ctrl+Alt+Left Arrow. The Remote Control/
Release Key option allows for the selection of other key options.
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Launching the Hyper-V Manager 
Launch Hyper-V Manager with the Administrative Tools Manager, Server Manager or Search. 

•	 Administrative Tools Menu – launch Hyper-V Manager by clicking on the Start → 
Administrative Tools → Hyper-V Manager menu option. 

•	 Server Manager – launch the Server Manager either from the Start → Administrative Tools → 
Server Manager menu option, or by clicking on the Server Manager icon in the task bar along the 
bottom of the desktop. 

•	 Search – click on the Start button, enter Hyper-V into the Search box and press enter. 

A Quick Tour of the Hyper-V Manager 
Once the Hyper-V Manager has loaded, it will appear as illustrated in the following figure: 

 

Figure 5: The Server Manager Hyper-V console

The left hand side contains a list of Hyper-V servers that are available for administration. By default the 
local server will be listed. 

Add remote Hyper-V servers to the list by right clicking on the Hyper-V Manager item in this panel and 
selecting Connect to Server....
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When selected, this menu option will display the Select Computer dialog. Select the local system (if it is 
not already listed) or to browse the network to find other remote Hyper-V servers from this dialog.

When remote server’s connections are established, they will appear in the list along with the local system. 
To remove service select the service and click on the Remove Server link in the Actions panel. 

The central panel contains three sub-panels. The top panel provides a list of virtual machines that are 
configured on the server currently selected in the right hand panel. The list contains the VM name,  
CPU usage, uptime, and operations information. Right click the virtual machine to view the commands 
that can be accessed. Select the Connect... action option or double-click on the entry in the list to display 
the console. Once selected, the Connection tool will appear displaying virtual machine console. 

The central panel contains a list of snapshots that have been taken for the selected virtual machine. 

Select a snapshot from the list to display a list of actions in the right hand panel or right click on a specific 
snapshot in the list. The bottom panel displays additional information about the currently selected item.

Managing a Running VM
Hyper-V can boot the installer for any supported operation system from the ISO file. It can also perform a 
network boot (using the Legacy Network Adapter, discussed later). After booting, you can go through the 
install process just like you would if installing the OS on a physical machine. Figure 6 shows the familiar 
screen presented when Server 2003 is booted from its media.

Figure 6: Installing an OS in Hyper-V is just like installing the OS on a physical system
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Figure 7 shows what a VM looks like after it has booted up. The Windows 7 client inside this VM sees 
its host as any other hardware and has no reason to know it is running on a VM. We are connected to 
this host via VMConnect (discussed later), but we could enable RDP on the host and use Remote Desktop 
to connect. 

Figure 7: VMConnect displaying a running Windows 7 guest.

The toolbar of VMConnect gives us the option to Stop, Pause, Turn off, and Reboot a VM. Taking a 
closer look at the Action menu, we can see this is where we would insert the Integration Services disc 
if our guest OS required that (Figure 8). We can also take snapshots or revert to a snapshot (if the VM is 
turned off ). 
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Figure 8: VMConnect Actions to perform on a running VM 

Hyper-V allows guests to access two types of optical disks. First, Hyper-V adds the convenience of being 
able to use ISO images inside guests without having to burn them. Operating Systems can be installed 
directly from an ISO on a local disk, SAN, or network share. Secondly, Hyper-V guests can access the host’s 
physical CD/DVD drive as if it were attached directly to the guest. This is called “capturing” the drive. 
The same can be done with Floppy Disks using VFD files and the host’s floppy drive.

Figure 9: Choosing an Optical Drive for the Virtual Machine.  
Insert Disk… will allow us to insert an ISO file on the guest, or Capture…  a physical DVD drive.

Customizing Hyper-V Manager 
The sizes of the various panels may be changed by moving the mouse pointer to the border of a panel. 
The specific panels that are displayed may also be configured by selecting View from the Actions panel 
and clicking on Customize.

Hyper-V Configuration Settings 
The Hyper-V Manager provides the ability to make changes. Click the Hyper-V Settings in the right hand 
Actions panel to access settings. 
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Figure 10: Hyper-V Settings

Understanding Hyper-V Server (Free Standalone Product) 
Hyper-V Server is a free bare-metal Hypervisor based on Server 2008 that allows you to run the same VMs 
that you would run on either Full Server 2008 or Server Core. It does not require an existing or licensed 
copy of Windows to be installed on the hardware, but VMs inside Hyper-V Server should be licensed 
appropriately. The Hyper-V Server standalone product is a useful tool for testing environments and MCTS/
MCITP study labs. VMs created on Hyper-V Server can be moved to full versions of Windows Server 2008 
hosts. Hyper-V Server can access all the same hardware that Server 2008 can access, and includes an 
iSCSI initiator. Although the features it comes with are limited, it does have a configuration utility called 
hvconfig.cmd that runs on startup (Figure 11).  

Limitations of Hyper-V Server:

•	 Hyper-V Server does not automatically license any guest instances of Server 2008.

•	 The parent partition of Hyper-V Server will not run any applications or roles besides Hyper-V.

•	 The parent partition of Hyper-V Server cannot be a domain controller.

•	 RAM: 1 gigabyte minimum, more than 2 gigabytes recommended, 32 gigabytes maximum.

•	 Up to 4 virtual processors per machine.

•	 You cannot manage Hyper-V from the server itself. It must be done remotely.

•	 PowerShell and BitLocker are not included.
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Note: These specifications refer to the R1 release of Server 2008, which is what the 70-652 exam targets. 

For R2 (exam 70-659), Microsoft has increased the capabilities of Hyper-V Server in 2008 R2. This includes 
adding migration support and allowing more RAM to be used by guests.

1.	 Download the ISO file containing Microsoft Hyper-V Server from Microsoft. 

2.	 Burn the 929 MB ISO file to a DVD or create a bootable USB disk or use a network-based  
install method.

3.	 Boot your Hyper-V capable server from the installation media.  
Wait until Windows is finished is loading files.

4.	 Select your language. 

5.	 Select your regional and keyboard settings. When done press Next.

6.	 Press Install Now.

7.	 Read the End User License Agreement (EULA) and select the I accept the license terms option 
before pressing Next. 

8.	 Select the Custom (advanced) option for installation (Upgrade is unavailable).

9.	 Partition the disk(s) and press Next to commence installation.

10.	 Wait for the Installation wizard to copy files, expand files, install features and install updates. 

11.	 Logon to the freshly created Hyper-V server installation by pressing the Other User button 
and specifying Administrator as the username and a blank password. Type a new password 
afterwards and confirm it.

12.	 After logon the Hyper-V Configuration Tool hvconfig.cmd automatically launches. Use it to:

a.	 Change workgroup settings or domain membership settings (requires restart) 

b.	 Change the computer name (requires restart)

c.	 Change network settings 

d.	 Add local Administrator accounts 

e.	 Change Windows Update settings 

f.	 Download and install Windows updates

g.	 Change Remote Desktop settings 

h.	 Change Regional and Language settings (through inet.cpl) 

i.	 Change Date and Time settings (through timedate.cpl) 

j.	 Log off, restart and shutdown the box 

k.	 Exit to the command prompt 

http://www.preplogic.com/products/video/view-video-training.aspx


Exam Manual  n  Configuring Windows Server Virtualization (70-652)                                                                     1-800-418-6789

LearnSmart                                                               Cloud Classroom:  Video Training  n   Practice Exams  n  Audiobooks  n  Exam Manuals

Figure 11: Hyper-V Server startup and hvconfig.cmd menu

Domain 2: Configuring Hyper-V
Configuration Options
Configuration settings include server and user settings which are used to specify where files are stored 
and control interactions such as keyboard combinations and logon credentials. 

•	 Server settings specify the default location of virtual hard disks and virtual machines.

•	 User settings enable customized virtual machine connection interactions and display messages 
and wizard pages if hidden previously. Virtual Machine Connection settings include the mouse 
release key and Windows key combinations.

Configure Hyper-V Settings
1.	 Navigate to Start → Administrative Tools → Hyper-V Manager.

2.	 In the Actions pane, click Hyper-V Settings.

3.	 In the Navigation Pane click the setting to be configured. 

4.	 Click OK to save the changes and close Hyper-V Settings.

Or click Apply to save the changes and configure other settings.
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Additional considerations
By default, membership in the local Administrators group, or equivalent, is the minimum required 
to complete this procedure. However, an administrator can use Authorization Manager to modify the 
authorization policy so that a user or group of users can complete this procedure. 

New Configuration Wizard 
The Virtual Network Manager’s New Configuration Wizard action item allows for the creation of new 
virtual machines, hard disks, and floppy disks. 

Figure 12: The New Configuration Wizard

Configuration option specifics include: 

•	 New → Virtual Machine - creates a new virtual guest session. 

•	 New → Hard Disk - creates a new hard disk image. Usually, an entire new machine would be 
created in the first option that includes the RAM, network adapter, video, CD/DVD, and other 
settings. Create a new hard disk image for that configuration, and use the wizard to walk-through 
configuration of a hard disk image.

•	 New → Floppy Disk - take an existing floppy disk and create a virtual floppy disk image from the 
physical disk. Example - use to create an image of a bootable floppy disk that will later be used, 
configured, or managed as a guest image. 

Setting Permissions in Hyper-V
Authorization Manager is a snap-in available in Server 2008 that can set detailed permissions for Hyper-V 
security. Use the same measures to safeguard a virtualization server as for any server running Windows 
Server 2008. Use extra measures to help secure the virtual machines, configuration files, and data. 
Authorization Manager contains:

•	 Authorization Manager snap-in (AzMan.msc) – use the Microsoft Management Console (MMC) 
snap-in to select operations, group them into tasks, authorize roles to perform specific tasks, and to 
manage tasks, operations, user roles, and permissions. To use the snap-in, create an authorization 
store or open an existing store. 

•	 Authorization Manager API – the API provides a development model to manage groups, 
business rules, and store authorization policies.  

Start Authorization Manager

1.	 To open Authorization Manager, click on Start → Run. In Run prompt, enter azman.msc.

2.	 To open a command prompt, click Start, point to All Programs, point to Accessories, and then 
click Command prompt, enter azman.msc.
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Authorization Manager opens without a default authorization store. Authorization Manager requires a 
data store (authorization store) for the policy that correlates roles, users, and access rights, maintained in 
an Active Directory database or in a local server XML file running the Hyper-V role. If an Active Directory 
database is used for the authorization store, Active Directory Domain Services (AD DS) must be at the 
Windows Server 2003 functional level.

Access to the XML file is controlled by the discretionary access control list (DACL) on the file, 
which grants or restricts access to the entire contents of the file. Backup the XML file regularly. Secure the 
virtual machines running on the virtualization server according to individual procedures for securing 
that kind of server or workload. 

Hyper-V Security Best Practices 
The parent operating system uses a Server Core installation of Windows Server 2008 which is less likely to 
be compromised and reduces maintenance of patches, updates, and restarts. There is no way to upgrade 
from a Server Core installation to a full installation of Windows Server 2008. Run all applications on virtual 
machines to reduce updates.  

•	 Use the virtual machine security level to determine the security level of your management 
operating system. Deploy virtual machines onto virtualization servers that have similar security 
requirements to make management and movement of virtual machines easier. 

•	 Do not give virtual machine administrators permissions on the management operating 
system. Give virtual machine administrators the minimum permissions required. Use Role-based 
access control.

•	 Ensure that virtual machines are fully updated before they are deployed in a production 
environment. Use the same methods and procedures to update virtual machines as used to 
update physical servers. Ensure that virtual machines are updated and/or patched before they  
are deployed. 

•	 Ensure integration services are installed on virtual machines. Timestamps and audit log 
entries are important for computer forensics and to ensure compliance. Integration services ensure 
that time is synchronized between virtual machines and the management operating system. 

•	 Use a dedicated network adapter for the virtualization server management operating 
system. By default, no virtual networking is configured for the management operating system. 
Use a dedicated network adapter for managing the server running Hyper-V and do not expose it 
to un-trusted network traffic. Do not allow virtual machines to use this network adapter. Use one or 
more different dedicated network adapters for virtual machine networking. 

•	 Use BitLocker Drive Encryption to protect resources. BitLocker Drive Encryption works with 
features in server hardware and firmware to provide secure operating system boot and disk drive 
encryption, even when the server is not powered on. 

Non-Administrator Permission to Create VMs
In domain environments, domain admin group will have full permissions to create and manage VMs on 
host servers. It’s often necessary to grant additional permissions, such as the ability to start and stop VMs, 
to other users who should not also have full administrative permissions. Authorization Manager Snap-in, 
also known as AzMan.msc is the primary method for defining and managing permissions for Hyper-V. 
The default location for the permissions settings XML file is in the following path: %ProgramData%\
Microsoft\Windows\Hyper-V\InitialStore.xml
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Using Authorization Manager 
To access the AzMan Snap-In on full installations of Windows Server 2008, click Start → Run and then 
type Azman.msc. By default, AzMan is not connected to any specific security data store. To access 
the default Hyper-V settings, right-click on the Authorization Manager object and select Open 
Authorization Store. Select the XML File option and then browse to %ProgramData%\Microsoft\
Windows\Hyper-V\InitialStore.xml. 

Managing Hyper-V Permissions  
To give non-administrator users full permissions:

1.	 On the Hyper-V Authorization – [Console Root\Authorization Manager\InitialStore.xml\
Hyper-V service] window. 

2.	 Right-click the Administrator object. 

3.	 Select Assign Users and Groups. 

4.	 Windows security principals or AzMan roles can be added. 

Creating Role Definitions 
Allow specific users to perform specific operations by creating new role definition objects. Regulate 
configuration roles by using AzMan.  

Hyper-V Integration Services
Hyper-V Integration Services are available in a child partition only after they are installed in supported 
guest operating systems. Integration Services communicate with components in the parent partition 
virtualization stack that are implemented as virtual devices (VDEVs). Communications between the parent 
and child partition components takes place over the Hyper-V VMBus. The VMBus supports high-speed, 
point-to-point channels for secure inter-partition communication and enhances performance. 
A separate, dedicated VDEV manages each of the parent partition Integration Services functions. 
A separate, dedicated service manages the Integration Services function in the child partition.

Integration Services target specific areas that enhance the functionality or management of supported 
guest operating systems. It is important to note that only a subset of Integration Components may be 
supported for some legacy or non-Windows guest operating systems. Since VSS is only supported in 
Windows operating systems beginning with Windows Server 2003, the VSS Integration Component is not 
be available for Windows 2000 Server, Windows XP, or supported Linux distributions.

Time Synchronization
Integration Services time synchronization includes:

•	 Keeping time synchronized in the guest operating system to account for time-drift in  
the virtual machine. 

•	 Restoring a virtual machine from a snapshot or saved state where a significant period has passed 
since the guest operating system last synched time. 

Parent partition-based time synchronization helps resolve the following issues: 

•	 Lack of network connectivity which makes traditional network-based protocols unusable.

•	 Need for quicker time synchronization than network-based protocols can provide to allow fast 
virtual machine startup after a saved state or in restoring a snapshot.

•	 Need for successful time synchronization in the event that significant time has passed since the 
virtual machine was last online. (i.e., a saved state or snapshot).
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Heartbeat
The Integration Services heartbeat detects whether a guest operating system running in a child partition 
becomes unresponsive. The parent partition sends regular heartbeat requests to a child partition and 
logs an event if a response is not received within a defined time boundary. If a heartbeat response is not 
received within the expected delay, the parent partition will continue to send heartbeat requests and 
generate events for missing responses.

Shutdown
Integration Services provides a virtual machine shutdown function. The shutdown request is initiated 
from the parent partition to the child partition using a Windows Management Instrumentation (WMI) call. 

Key/Value Pair Exchange
Integration Services key/value pair exchange provides a means to set, delete, and enumerate specific 
information about the virtual machine and guest operating system configuration running in a child 
partition. The parent partition can request to set specific data values in the guest operating system, or 
retrieve the data to expose it to third-party management or other tools.

Key/value pair data is stored in the following guest operating system registry locations:

•	 HKLM\Software\Microsoft\Virtual Machine\Auto

•	 HKLM\Software\Microsoft\Virtual Machine\External

•	 HKLM\Software\Microsoft\Virtual Machine\Guest\Parameters

By default, the child partition exposes the data stored in HKLM\Software\Microsoft\Virtual Machine\
Auto to the parent partition upon request.    

The parent partition provides the values in HKLM\Software\Microsoft\Virtual Machine\Guest\
Parameters to the child partition. Parent Partition values include; hostname, physicalhostname, 
physicalhostnamefullyqualified, and virtualmachinename.  

Guest Operating Systems
For guest operating systems that support VSS, Integration Services allows the parent partition to request 
the synchronization and inaction of a virtual machine running in a child partition. If all guest operating 
systems support VSS, a backup of the entire Hyper-V server including all offline and online virtual 
machines can be accomplished using a VSS snapshot.

Integration Services Installation Procedure

The installation of Integration Services should be performed after the guest operating system loads for 
the first time. 

1.	 Launch the Virtual Machine Connection application from within the Hyper-V Manager  
console to connect to the guest operating system, and log in with an account that has 
administrative privileges. 

2.	 Select the Insert Integration Services Setup Disk option from the Action menu. This will attach an 
ISO image named vmguest.iso to the virtual machine DVD drive. 

3.	 The installation of Integration Services should begin automatically. Restart the virtual machine 
when the installation completes. 

4.	 Verify the Integration Services installed in the guest operating system by browsing services.  
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Hyper-V Integration Services Support
Hyper-V Integrated Services supported operating systems are illustrated in the following table. Only 
certain guest operating systems are supported. Some are only compatible.

 Operating System
Time 

Synchronization
Heartbeat Shutdown

Key/ Value 
Pair Exchange

VSS

Windows Server 2008 x64 Y Y Y Y Y

Windows Server 2008 x86 Y Y Y Y Y

Windows Server 2003 x64 
with SP2 

Y Y Y Y Y

Windows Server 2003 x86 
with SP2

Y Y Y Y Y

Windows 2000 Server  
with SP4

Y Y Y Y N

Windows 2000 Advanced 
Server with SP4

Y Y Y Y N

Windows Vista x64 with SP1 Y Y Y Y Y

Windows Vista x86 with SP1 Y Y Y Y Y

Windows XP x86  
with SP2/SP3

Y Y Y Y N

Windows XP x64 with SP2 Y Y Y Y N

Suse Linux Enterprise 
Server 10 x64

N N N N N

Suse Linux Enterprise 
Server 10 x86

N N N N N

Figure 13: Hyper-V Integrated Services supported operating systems
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Hyper-V supports the following guest operating systems running in child partitions: Hyper-V Aware 
Windows Operating Systems, Hyper-V Aware non-Windows Operating Systems and Non Hyper-V Aware 
Operating Systems. 

•	 Hyper-V Aware Windows Operating Systems (enlightened operating systems) – able to detect 
that they are running on the Hyper-V hypervisor and modify behavior to maximize performance 
(such as using hypercalls to directly call the hypervisor). These operating systems are able to host 
the Integration Services to perform such tasks as running Virtual Service Clients (VSCs) which 
communicate over the VMBus with the Virtual Service Providers (VSPs) running on the root 
partition for device access. 

•	 Hyper-V Aware Non-Windows Operating Systems – also able to run Integration Services and, 
through the use of VSCs supplied by third parties, access devices via the root partition VSPs. The 
enlightened operating systems are also able to modify behavior to optimize performance and 
communicate directly with the hypervisor using hypercalls. 

•	 Non Hyper-V Aware Operating Systems – unaware that they are running on a hypervisor and are 
unable to run the Integration Services. To support these operating systems, the Hyper-V hypervisor 
uses emulation to provide access to device and CPU resources. This approach allows unmodified, 
unenlightened operating systems to function within Hyper-V virtual machines.

Virtual Network Manager
Hyper-V Virtual Network Types 
Hyper-V provides the virtual machine the ability to create multiple virtual networks. Virtual network types 
supported by Hyper-V are:

•	 External Virtual Network – access to external network via a physical network adapter installed 
in the host system; can communicate with parent partition and other virtual machines running on 
the same network.

•	 Internal Virtual Network – access to parent partition and other virtual machines attached to the 
same virtual network; does not require a physical network adapter, no access to external network. 

•	 Private Virtual Network – access only to other virtual machines attached to the same virtual 
network; does not require a physical network adapter, no access to parent partition, no access to 
external network.
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Figure 14: Adding a New Virtual Network Adapter

Existing Virtual Network Switches  
Current VM configured network switches will be listed individually in the left pane of the Virtual Network 
Manager dialog box. Select an existing virtual network switch to change the name of the virtual switch, 
change the internal or external connection that the switch has access to, or remove the network  
switch altogether. 

Hyper-V Server Remote Administration:

•	 One-to-one correspondence between external virtual networks and physical networks adapters

•	 Not possible to bind more than one external virtual network to a physical network adapter. 

•	 If multiple external virtual networks are required, a physical network adapter must be installed in 
the host system for each one. 

•	 In Hyper-V server remote administration, a separate physical network adapter is necessary. 
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Creating a New Hyper-V Virtual Network 
Access the Virtual Network Manager. Launch the Hyper-V Manager (Start → Administrative Tools → 
Hyper-V Manager).  Unless the Hyper-V Manager is already connected to the required Hyper-V Server, 
connect to the appropriate server in the left hand panel by right clicking on Hyper-V Manager in the 
left hand panel. Select Connect to Server. When the server is connected, click on the Virtual Network 
Manager link in the Actions panel. Once loaded, the manager dialog will appear as you see in  
Figure 15, below. 

The left hand pane in the Virtual Network Manager contains a list of existing virtual networks configured 
on the selected Hyper-V server. At the top of the list is the option to Add Virtual Network which,  
when selected, provides the option to add an External, Internal or Private virtual network. Once the 
virtual network type has been selected, the main panel will change to display the virtual network  
settings screen. 

In the case of private and internal virtual networks, the name of the virtual network needs to be specified. 
For external private networks, select a physical network adapter from the drop down list. 

Figure 15: Adding a new virtual network

The Enable virtual LAN identification for parent partition option is only available for external and 
internal virtual networks, and requires a physical network adapter with VLAN support. 
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Assigning Virtual Machines to Virtual Networks 
The virtual machine needs a virtual network adapter to connect to a virtual network. A single virtual 
machine can contain multiple virtual network adapters, though each virtual network adapter can be 
connected to only one virtual network. It is possible for multiple virtual adapters to connect to the same 
virtual machine. 

Security Considerations
Firewall and antivirus software running on the host operating system do not protect guest 
operating systems. Install firewall and antivirus software directly on the guest operating systems to 
obtain this protection.

Connect to existing Hyper-V virtual network:
Ensure that a virtual network adapter is available. Right-click the virtual machine to view currently 
configured virtual hardware devices. Select Settings.... The right hand panel of the settings dialog 
contains a list of hardware, including any virtual network adapters and information about the virtual 
networks to which they are attached. 

To add a new adapter, select Add Hardware from the top of the device list, select Network Adapter from 
the list in the main panel and click Add to proceed to the settings screen for the new adapter. On this 
screen, select the virtual network to which the device is to be attached and click Apply to commit the 
configuration changes. 

VLAN Tagging
Virtual LAN (VLAN) tagging allows for isolating network resources using a virtual switch.   VLAN tagging is 
a way to segment traffic on your network. VLAN tagging was originally implemented on physical switches 
and routers before it first appeared in virtual switches. The most common way to implement VLAN tags in 
an infrastructure is to apply a VLAN tag to a switch port. In this model the switch adds the tag to all frames 
that flow through that port.

It is important that the networking infrastructure knows how to handle the VLAN tags that have been 
setup because they affect the routing of the packets and are part of the TCP/IP packet itself. This means 
that routers and switches must know how to evaluate a VLAN tag in order to determine where to route a 
particular packet. 

High Availability Configuration
Availability means that users are able to access a system to do their work. Whereas high availability 
ensures operational continuity which is accomplished through the use of the Windows Server 2008 
Failover Cluster feature. 

Virtual machines can be managed by the Failover Cluster which can be used inside virtual machines to 
monitor and move VM workloads. 

Hosts and Guests 
Guest is the Hyper-V OS and environment that is running in a child partition. Host is the physical machine 
being managed by the OS on the Hyper-V parent partition.  
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The Windows Server 2008 Failover Cluster configuration has the following advantages:

•	 VMs can be moved to other cluster nodes if the physical machine that Hyper V and the VM are 
running on needs updating, changes, or rebooting.  

•	 If the physical machine that Hyper-V and the VMs are running on fails in some respect   the other 
members of the Failover Cluster will bring the VMs online automatically. 

•	 If the VM fails, it can be restarted on the same Hyper-V server or moved to another Hyper-V server.  

Differences Between Planned and Unplanned Downtime

•	 Planned downtime – a scheduled function such as in hardware servicing or software patching. 

•	 Unplanned downtime – unexpected situation, such as a server is offline and all the VMs running 
on that server need an automatic restart without interruption. 

Quick Migration
Quick Migration moves running virtual machines from one physical computer to another. There is 
downtime with quick migration because the VM is saved, moved, and restored. 

To use quick migration a cluster needs to be created with either Windows Server 2008 Enterprise or 
Windows Server 2008 Datacenter. Standard edition does not support clustering. The following diagram 
shows an example of a cluster setup. The public network is used to connect these cluster nodes and the 
virtual machine, to other network resources. The private network is used for cluster-related network traffic 
such as a heartbeat and lets the cluster nodes verify the state of other cluster nodes. 

Figure 16: Quick migration scenario schematic
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System Requirements
System requirements include software, hardware, network and storage requirements and guidelines for a 
quick migration scenario.

Host Nodes Software Requirements

•	 Windows Server 2008 Enterprise or Windows Server 2008 Datacenter (with Hyper-V) must be 
installed on the nodes (Standard does not have Failover clustering capabilities).

•	 Licensed copies of the operating system and other software to run on the guest virtual machine. 

•	 A name-resolution service; such as Domain Name System (DNS), DNS dynamic update protocol, 
Windows Internet Name Service (WINS), or Hosts file. 

•	 All cluster nodes must be in the same Active Directory domain.  

Hardware Requirements and Guidelines

•	 64-bit server environment. 

•	 Support for hardware-assisted virtualization technology.

•	 Cluster nodes must have identical hardware and the same processor architecture. Moving 
between AMD and Intel will not work. Moving between an Intel Core 2 Duo and an Intel Core i7 
will not work.

•	 Compatible hardware components because the failover cluster is installed on a storage area 
network (SAN), with multiple devices and clusters sharing the SAN with a cluster.

•	 Hardware minimum requirements: 1.0 GHz CPU speed, Intel VT or AMD-V, and Minimum RAM of 
512 MB (additional needed for each guest operating system), DEP (Data Execution Prevention: 
AMD-ND or Intel-XD).

Network Requirements and Guidelines

•	 Each cluster node requires at least two network adapters and must be connected by two or  
more independent networks, and at least two LANs or VLANs are required to prevent a single  
point of failure. 

•	 Nodes in cluster must be able to access an Active Directory domain controller. The domain 
controller should be in the same location and on the same LAN as the nodes in the cluster. 

•	 Network configuration includes several NIC’s for management and virtual networking. 

Storage Requirements and Guidelines  

•	 This external storage unit to be used as storage must be connected to all nodes in the cluster.  
Use some type of hardware redundant array of independent disks (RAID).

•	 If using iSCSI, each node must have a network adapter dedicated to the cluster storage. 

Set Up a Cluster
For quick migration set up a cluster with your servers. Determine which servers will be in the cluster,  
and then use the wizard. Decide on the amount of memory available to a virtual machine, which can be 
altered depending on VM needs. 
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Install Windows Server 2008
First, install Windows Server 2008 Enterprise or Windows Server 2008 Datacenter in the same domain 
on the host servers that will become the cluster nodes. Log on locally with a domain account that is a 
member of the local administrators group on all nodes. Then install the failover cluster feature. Hyper-V is 
installed by default.

Once Windows Server 2008 Hyper-V is installed, manage with the Microsoft Management Console (MMC) 
in the same way that other server roles are managed.  

Configure the Cluster

1.	 Set up network

2.	 Set up and configure cluster disks

3.	 Create the server cluster

Create a Virtual Machine

1.	 Use the Hyper-V New Virtual Machine Wizard to create a virtual machine. 

2.	 Define name and location, memory size, and the network information.

Create the Host Cluster
The host cluster can be created once the virtual machine resides on the shared storage. Decide which 
resources need to be highly available and which machines need to be clustered. Set up the host cluster 
using a wizard within the Cluster Management snap-in. Select the service or application to be configured 
for high availability from a list of options. 

Select Virtual Machine
A wizard scans for configuration files (VMCs) and a list of all available virtual machines, their status, 
and their host servers’ displays. Virtual machines are added automatically. Select multiple virtual machines 
to make highly available. Now, the virtual machines are clustered, along with appropriate shared storage. 

Fail Over a Workload with Quick Migration
When the virtual machine is online use quick migration to move it between host servers. Start in the 
Failover Cluster Management console. The console shows the virtual machines running on the individual 
nodes. Highlight a virtual machine to view a summary of its properties. 

Right click the virtual machine name to display the Actions menu. The Actions dropdown displays 
with the option to move the virtual machine to another node and to select the destination node. 
Once the command has been run, the virtual machine enters a pending state before it is moved. After a 
few seconds, the virtual machine appears on the destination node and the status will return to Online. 
The quick migration process is complete. 

Domain 3: Hyper-V Remote Configuration 
Understanding Remote Administration
Hyper-V is managed using Windows Management Instrumentation (WMI). WMI allows   Hyper-V manager 
to be installed on a client machine that is running Server 2008, Windows 7, or Vista SP1.

Configuring Remote Administration
Install the Hyper-V management tools on a full installation of Windows Server 2008 and on Windows Vista 
Service Pack 1 (SP1). The minimum requirement to complete this procedure is Membership in the local 
Administrators group. 
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Installing the Management Tools
Obtain and apply the appropriate operating system update to install the management tools.  
Update locations:

•	 Windows Update – if computer is not set up to install updates automatically, install manually.

•	 Microsoft Download Center – download the file to the computer and then double-click  
the .msu file.

If installing the tools on Windows Vista SP1, no additional installation steps are required, so proceed to the 
configuration instructions. 

If installing the tools on Windows Server 2008, complete the remaining steps. Open Server Manager. In 
Server Manager, under Features Summary, click Add Features. On the Select Features page, expand 
Remote Server Administration Tools, and then expand Remote Administration Tools. Click Hyper-V 
Tools, and then proceed through the rest of the wizard. 

Figure 17: Installing Hyper-V Remote Administration Tools on Server 2008.

Configuring the Management Tools
The configuration process consists of modifying various components that control access and 
communications between the server running Hyper-V and the computer on which the Hyper-V 
management tools will be run. 

No additional configuration is required if using the management tools on a computer running Windows 
Server 2008 and the same user account is a member of the Administrators group on both computers.
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Configuring the Server Running Hyper-V
The following procedures describe how to configure the server running Hyper-V. When domain-level 
trust is not established, perform all the steps. When domain-level trust exists but the remote user is not 
a member of the Administrators group on the server running Hyper-V, modify the authorization policy, 
but skip the steps for modifying the Distributed COM Users group and the Windows Management 
Instrumentation (WMI) namespaces. 

Remote Management Connections
For a full installation of Windows Server 2008:
The following procedures assume the Hyper-V role is installed on the server. Enable the WMI firewall rules. 
From an elevated command prompt, type: 

netsh advfirewall firewall set rule group=“Windows Management Instrumentation (WMI)” 
new enable=yes. 

If the command succeeds, the display should read: Updated 4 rules(s). Ok. 

1.	 To verify, view the results in Windows Firewall with Advanced Security: 

2.	 Click Start → Control Panel. Use Classic View. 

3.	 Click Administrative Tools → Windows Firewall with Advanced Security. 

4.	 Select inbound rules or outbound rules and then sort by the Group column. 

There should be three inbound rules and one outbound rule enabled.
Add Remote User to the Distributed COM Users group:
 

1.	 Navigate to Start → Administrative tools → Computer Management. 

2.	 If User Account Control is enabled, click Continue. 

3.	 Component Services opens.

4.	 Expand Local Users and Groups, and then click Groups.

5.	 Right-click Distributed COM Users and click Add to Group. 

6.	 In the Distributed COM Users Properties dialog box, click Add. 

7.	 In the Select Users, Computers, or Groups dialog box, type the name of the user and click OK. 

8.	 Click OK again to close the Distributed COM Users Properties dialog box. 

9.	 Close Component Services.

The remaining steps grant the required remote user WMI permissions for two namespaces: the CIMV2 
namespace and the virtualization namespace.

1.	 Navigate to Start → Administrative tools → Computer Management. 

2.	 In the Navigation pane, click Services and Applications, right-click WMI Control, and then  
click Properties. 

3.	 Click the Security Tab → Root → CIMV2. 

4.	 Below the namespace list, click Security. 

5.	 Check to see if the appropriate user is listed in the Security for ROOT\CIMV2 dialog box. If not, 
click Add. 

6.	 In the Select Users, Computers, or Groups dialog box, type the name of the user and click OK.
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7.	 Back on the Security tab, select the name of the user. 

8.	 Under Permissions for [user or group name], click Advanced. 

9.	 On the Permissions tab, verify that the user is selected and then click Edit. 

10.	 In the Permission Entry for CIMV2 dialog box, modify the following: 

a.	 For Apply to, select This namespace and subnamespaces.

b.	 In the Permissions list, in the Allow column, select the Remote Enable check box.

c.	 Below the Permissions list, select the Apply these permissions to objects and/or 
containers within this container only check box.

d.	 Click OK in each dialog box until you return to the WMI Control Properties dialog box. 

You’ll need to repeat the process for the virtualization namespace. Scroll down to see the 
virtualization namespace. 

1.	 Click virtualization; below the namespace list, click Security.

2.	 In the Security for ROOT\virtualization dialog box, check to see if the appropriate user is listed.  
If not, click Add. 

3.	 In the Select Users, Computers, or Groups dialog box, type the name of the user and click OK.

4.	 On the Security tab, select the name of the user. Under Permissions for [user or group name], 
click Advanced. 

5.	 On Permissions tab, verify that the user is selected, click Edit. 

6.	 In the Permission Entry for virtualization dialog box, modify the following settings:

a.	 For Apply to, select This namespace and subnamespaces.

b.	 In the Permissions list, in the Allow column, select the Remote Enable check box.

c.	 Below the Permissions list, select the Apply these permissions to objects and/or 
containers within this container only check box.

7.	 Click OK in each dialog box and then close Computer Management.

8.	 Restart the server to apply the changes to the authorization policy.

For a Server Core installation of Windows Server 2008 
Enable server Windows Management Instrumentation firewall rules. From an elevated 
command prompt, type:

netsh advfirewall firewall set rule group=“Windows Management Instrumentation (WMI)” 
new enable=yes 

If the command is successful, it displays the message: Updated 4 rules(s). Ok.

Next, modify the Distributed COM permissions to provide access to the remote user.  Type: net localgroup 
“Distributed COM Users” /add [domain_name]\[user_name] where [domain_name] is the domain that 
the user account belongs to and [user_name] is the user account who will have remote access.

Next, connect remotely to the server running the Server Core installation to modify the authorization 
policy and the two WMI namespaces, using MMC snap-ins that are not available on the Server 
Core installation. 

Log on to the computer on which the Hyper-V management tools are run, using a domain account that is 
a member of the Administrators group on the computer running a Server Core installation.
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If the user who requires remote access to the server running Hyper-V belongs to the Administrators group 
on both computers, then it is not necessary to configure the authorization policy. Authorization policy 
configuration assumes that the default authorization policy has not been modified, including the default 
location, and that the account for remote access requires full Hyper-V administrative role access. 

1.	 Click Start → Start Search and type azman.msc. 

2.	 If prompted to confirm the action, click Continue. Authorization Manager Microsoft 
Management Console (MMC) snap-in displays. 

3.	 In the Navigation pane, right-click Authorization Manager. 

4.	 Click Open Authorization Store. 

5.	 Make sure that XML file is selected. 

6.	 Browse to the %system drive%\Program Data\Microsoft\Windows\Hyper-V folder. 

7.	 Select InitialStore.xml → Open and Click OK. 

By default, the Program Data folder is a hidden folder. If the folder is not visible, type: <system_drive>\
ProgramData\Microsoft\Windows\Hyper-V\initalstore.xml. 

1.	 In the Navigation pane, click Hyper-V services → Role Assignments. 

2.	 Navigate through Administrator → Assign Users and Groups → From Windows  
and Active Directory. 

3.	 In the Select Users, Computers, or Groups dialog box, type the domain name and user name of 
the user account, and then click OK. 

4.	 Close Authorization Manager.

5.	 Back in the Navigation pane, click Hyper-V services, and then click Role Assignments. 

6.	 Right-click Administrator, point to Assign Users and Groups, and then point to From 
Windows and Active Directory. 

7.	 In the Select Users, Computers, or Groups dialog box, type the user account domain name and 
user name, and then click OK. Close Authorization Manager. 

Granting required WMI permissions to a remote user for a Server Core installation is essentially the same 
as doing so for a full installation of Windows Server 2008.

Configuring Windows Vista SP1
Log on to the computer running Windows Vista SP1. 

Enable Windows Management Instrumentation firewall rules. From an elevated command prompt, type: 

netsh advfirewall firewall set rule group=”Windows Management Instrumentation (WMI)” 
new enable=yes. 

If the command is successful it will display the message: Updated 8 rules(s). Ok.  To verify that the 
command succeeded, view the results in Windows Firewall with Advanced Security. 

1.	 Navigate to Start  Control Panel. Switch to Classic View if not currently using that view. 

2.	 Click Administrative Tools, and then click Windows Firewall with Advanced Security. 

3.	 Select inbound rules or outbound rules and then sort by the Group column.

4.	 There should be six inbound rules and two outbound rules enabled for Windows  
Management Instrumentation.
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Next, you need to enable a Microsoft Management Console firewall exception. From an elevated 
command prompt, type:  

netsh firewall add allowedprogram program=%windir%\system32\mmc.exe name=”Microsoft 
Management Console”  

Afterwards, start Hyper-V Manager to verify connection has been made with the remote server.  

1.	 Click Start, click the Start Search box, type Hyper-V Manager and press Enter. 

2.	 If prompted to confirm the action, click Continue. 

3.	 In Hyper-V Manager, under Actions, click Connect to Server. 

4.	 Type the name of the computer or browse to it, and click OK. 

5.	 If Hyper-V Manager can connect to the remote computer, the computer name will appear in the 
navigation pane and the results pane will list virtual machines configured on the server.

Install Hyper-V Manager on Windows 7   
Download the Hyper-V Remote Management Configuration Utility and its documentation. 
Now, download and install the Remote Server Administration Tools for Windows 7 (RSAT). After installing 
RSAT, open Control Panel, go to Programs and Features, and choose Turn Windows features on or off. 
Expand the Remote Server Administration Tools Heading and the Role Administration Tools subheading, 
and then select Hyper-V Tools as show below.

Figure 18: Hyper-V Remote Administration feature in Windows 7
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Remote Connectivity
Use the Virtual Machine Connection application to connect to a Hyper-V virtual machine, via the Connect 
option under the virtual machine Action pane. By default, only administrators have unrestricted access to 
the Hyper-V Manager console, including all VMs defined on permitted servers.

Use Remote Desktop Connection (mstsc.msc) to reach VMs from a distance. Windows Server 2008 licenses 
two built-in Remote Desktop connections out-of-the-box.

For Windows Server 2008 and Server Core, this feature must be enabled. Verify that the version of Remote 
Desktop Connection on the connecting host supports Network Level Authentication and Remote Desktop 
Protocol 6.1, required to successfully connect to Windows Server 2008 default installations and remote 
Server Core. RDC 6.0.6001 ships with these enhancements as part of Windows Server 2008. 

To enable remote desktop on the full version of Server 2008, go to Control Panel, then System, then click 
the Advanced System Settings link. The remote desktop settings are found under the Remote tab.

Figure 19: Allowing Remote Desktop in Server 2008.

To enable remote desktop on Server Core, run the following command from the Windows shell:

cscript %windir%\system32\SCRegEdit.wsf /ar 0
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Using RDP helps to maintain security on the box by minimizing the need for an administrator to 
grant unneeded Hyper-V Manager access privileges. In addition, there is also a significant decrease in 
memory resources per VM connection and with multiple VMs per host machine, this could significantly 
increase performance. Text can also be copied from the guest VM to the host machine. This cannot be 
accomplished with the Virtual Machine Connection application.

Remote Administration
Remote administration can be used to manage server settings, create and configure VMs, configure virtual 
networking, and control VM state. 

Manage server settings
Use Failover Cluster Manager snap-in to access virtual machine settings to make configuration changes. 
The cluster updates configuration changes automatically. However, if changes are made to the virtual 
machine settings from the Hyper-V Manager snap-in, update the cluster manually after the changes 
have been made. If the configuration is not refreshed after networking or storage changes are made, 
a subsequent failover may succeed, but if it doesn’t the virtual machine may be configured incorrectly.

Modify VM Settings 
In the Failover Cluster Manager snap-in expand Services and Applications, and then click the virtual 
machine to modify its settings. In the center pane right-click the virtual machine resource and then 
click Settings. If Settings does not display, collapse the virtual machine resource and then right-click it. 
The Settings interface appears. This is the same interface that is seen in Hyper-V Manager. 
Configure the settings for the virtual machine.

If the Hyper-V Manager is used instead of the Failover Cluster Manager to configure settings for 
a virtual machine, be sure to refresh the virtual machine configuration in Failover Cluster Manager. 
To do this, expand Services and Applications, and then click the virtual machine that needs to have its 
configuration refreshed. In the Actions pane, scroll down, click More Actions, and then click Refresh 
virtual machine configuration.

Run-Time Requirements
Virtualization services require x64-based system that supports hardware-assisted virtualization running 
Hyper-V. Programs that interact with the WMI interfaces however, can run remotely on any system that 
supports WMI.

About the Virtualization WMI Provider 
Microsoft Windows Server 2008 Hyper-V allows system administrators to consolidate separate hardware 
servers on to a single server running Microsoft Windows Server 2008 as the host OS.

Each hosted virtual machine runs in its own separate and isolated virtual environment. Some of the 
advantages include: 

•	 Easier administrator management

•	 Testing and support advantages

•	 Support and test legacy hardware

•	 Snapshot support

•	 User is able to monitor and control VM environment

•	 Easy customization

•	 WMI scripting can be done directly
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The Resource Virtualization Profile defines two different virtual resource classes:

•	 Shared Resource: Represents the resources of the host that are, or are capable of being shared 
among multiple virtual systems. 

•	 Synthetic Resource: Represents the virtual resources that have no corresponding host resource. 
Msvm_EmulatedEthernetPort is an example of a synthetic resource.

Virtualization WMI includes the following classes: BIOS, Input, Integration Components, Memory, 
Networking, Processor, Profile Registration, Resource Management, Serial Devices, Storage, Video, Virtual 
System, Virtual System Management.  

USNs
Active Directory Domain Services (AD DS) uses update sequence numbers (USNs) to keep track of 
data replication between domain controllers. Each time that a change is made to data in the directory, 
the change is added to the USN. Source and destination domain controllers use the Up-to-dateness vector 
and High water mark (direct up-to-dateness vector) replication process values to filter destination domain 
controller required updates. USN rollback occurs when the USN normal updates are circumvented and a 
domain controller tries to use a USN that is lower than its latest update.

Although it may not appear on your exam, do not pause any DC that is running as a Hyper-V guest. 
Doing so can cause USN synchronization between other DCs to fail.

Read-Only Domain Controllers
Read-only domain controllers (RODCs) are domain controllers in an Active Directory database that host 
read-only copies of the partitions. RODCs avoid most USN rollback issues because they do not replicate 
any changes to the other domain controllers. However, if an RODC replicates from a writeable domain 
controller that has been affected by USN rollback, the RODC is affected as well. Restore an RODC using an 
Active Directory compatible backup application rather than using a snapshot. 

Avoid Creating Single Points of Failure
Implement system redundancy to avoid introducing potential single points of failure. Consider the 
following recommendations while keeping in mind potential for increases in administration costs:

1.	 Run at least two virtualized domain controllers per domain on different virtualization hosts to 
reduce the risk of losing all domain controllers if a single virtualization host fails.

2.	 Diversify the hardware to limit damage that might be caused by a malfunction that is specific to 
a vendor configuration, a driver, or a single piece or type of hardware.

3.	 Domain controllers should be running on hardware that is located in different regions of 
the world, if possible to help reduce the impact of a disaster or failure that affects a domain 
controller site.

4.	 Maintain physical domain controllers in each domain to decrease the risk of a virtualization 
platform malfunction which would affect all host systems that use that platform.
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Security Considerations
Manage the host computer that is running virtual domain controllers as carefully as a writeable domain 
controller, even if that computer is only a domain-joined or workgroup computer. This is an important 
security consideration in minimizing attacks that can compromise all virtual machines, domains, 
and forests that the computer is hosting. 

Local administrator should have credentials equivalent to the default domain administrator. To avoid 
security and performance issues use a host running a Server Core installation of Windows Server 2008, 
with no applications other than Hyper-V. In a branch office or other locations that cannot be satisfactorily 
secured, a read-only domain controller (RODC) is recommended. If a separate management network exists, 
the host should be connected only to the management network.

Security Boundaries
Using virtual machines makes it possible to have many different domain controller configurations. 
Consider carefully the way that virtual machines affect boundaries and trusts in the Active 
Directory topology. 

Remote Desktop Protocol (RDP)
The most common remote connection is an RDP.  Instead of using Virtual Machine Remote Control (VMRC) 
to control virtual machines on a Hyper-V host by remote control, SCVMM uses the Remote Desktop 
Protocol (RDP). All supported versions of Windows Server 2008 and   Windows Vista SP1, SCVMM connect 
to the host via RDP with the default port of 2179. For any other operating system, SCVMM connects via 
RDP to the guest operating system with the default port of 3389. 

Change Remote Connections to Virtual Machines 
Applies To: System Center Virtual Machine Manager 2008 (including R2)
When a Windows Server-based host is added to System Center Virtual Machine Manager (SCVMM) using 
Add Hosts Wizard, remote connections to virtual machines on that host are enabled by default, and the 
default remote control connection port is obtained from the General Settings in Administration view. 
After a Windows Server-based host has been added, you can change the remote connection settings in 
the Host properties. In the Administration view, set the default port in General Settings. 

By default, encryption for VMRC connections is not enabled when a Virtual Server host is added. To 
enable encryption for VMRC connections, modify the remote connection host properties in the SCVMM 
Administrator Console.

Modify Hyper-V host remote connection settings

1.	 In Hosts view, locate the host group that contains the host to be modified. 

2.	 In the Results pane, double-click the host.

3.	 Click the Remote tab.

4.	 To enable or disable remote connections, select or clear the Allow remote connections to 
virtual machines on this host check box.

5.	 If remote connections are enabled, in the Remote connections port box, set the port that 
SCVMM will use to communicate with virtual machines on the Hyper-V host. The default port is 
2179; enter any value from 1 to 65535. No firewall exception for the port is needed.
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Modify Virtual Server host remote connection settings   

1.	 In Hosts view, locate to the host group that contains the host to be modified.

2.	 In the Results pane, double-click the host.

3.	 Click the Remote tab.

4.	 To enable or disable remote connections, select or clear the Allow remote connections 
to virtual machines on this host check box. If remote connections are disabled, all other 
configuration options become unavailable.

5.	 If remote connections are enabled, in the Remote connections port box, set the port that 
SCVMM will use to communicate with virtual machines on the Virtual Server host. The default 
port is 5900; enter any value from 1 to 65535. No firewall exception for the port is needed.   
If multiple users will be allowed to access virtual machines on this host, select the Allow 
multiple VMRC connections check box. 

6.	 If a time-out will be enforced for VMRC connections, select the Enable remote connection 
timeout check box and then specify the time-out interval. The default time-out interval is 
15 minutes; Enter any value from 1–600.

7.	 If there will be VMRC remote connection encryption for this host, select the Secure remote 
connection with this host check box. This option enables Secure Sockets Layer (SSL) encryption 
by using an unsigned certificate from Virtual Server. It is recommended that SSL security for 
VMRC remote connections be implemented, particularly if Basic authentication is used to 
transmit plain text passwords.

8.	 If using a signed certificate from a certification authority to implement SSL encryption, do one of 
the following:

9.	 Click Upload or replace certificate and then click Browse to upload or to replace a certificate.

10.	 Click Generate Certificate Request to open the Secure VMRC Certificate Request dialog box. 
Then, perform the following steps to generate a certificate request file that can be sent to a 
certification authority to obtain a certificate to upload:

a.	 In the appropriate boxes, type information about your organization.  Do not type more than 
two characters in the Country/Region box, or more than 64 characters in any other box.  
If exceeding these limits is expected, the certificate request file is created but is not valid for 
creating a certificate from a certification authority.

b.	 In the Key length list, choose the level of encryption the certificate will use.  
The default key length is 512 bits; select 1024, 2048, or 4096 bits from the list.  A certificate 
request with a key length greater than 4096 bits can be generated by using the New-
VMRCCertificateRequest cmdlet in Windows PowerShell - Virtual Machine Manager 
command shell. Generating a certificate request with a key length over 4096 bits may take 
quite awhile. Track the progress of the process in Jobs view.

c.	 In the Save request file to box, type the file path and file name for the certificate file,  
or click Browse to navigate to a folder, type the file name, and then click Save.

d.	 Click Generate to generate the certificate request file.

Hyper-V Integration Components 
Install the Hyper-V integration components through the SCVMM Administrator Console. Right-click 
powered-off virtual machine and select Install Virtual Guest Services. Hyper-V integration components 
are also automatically installed with:

•	 P2V conversion

•	 V2V conversion
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Authorization Manager allows administrators to integrate role-based access control to applications.  
The System Center Virtual Machine Manager (SCVMM) is an easy-to-use and cost-effective application for 
administrators who are responsible for managing virtual networks. SCVMM 2008 is a single application 
that allows you to configure and manage your entire virtual environment. 

Virtual networking is the way a virtual environment is configured to work on the physical components 
to allow other machines to access virtual resources through the physical network. In this chapter you 
learned about different virtual network concepts, such as VLANs, virtual switches, VLAN tagging, 
and the communication settings. One of the advantages that an administrator has is the ability to 
configure Hyper-V remotely. 

Objective Summary
Know how to use Authorization Manager. Authorization Manager allows integration of role-based 
access control to applications. This gives flexibility to assign application access to users based on  
their job functions. 

Understand System Center Virtual Machine Manager. Understand that System Center Virtual Machine 
Manager is an easy and cost-effective application for administrators that are responsible for managing 
virtual networks. Since SCVMM works with the Windows Server 2008 technology, understand that SCVMM 
allows the configuration and manipulation of the physical and virtual machines, consolidate underutilized 
physical machines, and implement new virtual machines. 

Know how to implement virtual networking. Be familiar with VLANs, virtual switches, VLAN tagging, 
and the three communication settings that you can configure. Be able to set up a network adapter in the 
Virtual Network Manager tool. 

Understand how to configure Hyper-V remotely. Know how to remotely configure and maintain 
Hyper-V remotely. Understand how to configure the Windows Firewall and RDP settings to allow for the 
remote administration.

Domain 4: Creating Virtual Hard Drives
Creating Hyper-V Virtual Hard Drives (VHD)
Virtual hard disks can be created as part of the virtual machine creation process or they can be created 
independently from the virtual machine. The VHD file stores the disk image that holds the data for a virtual 
machine’s hard drive.

Differing VHD Options
There are three different Hyper-V virtual hard disk types: 

•	 Fixed-size disks – use the amount of physical space that is specified when created. Fixed disks are 
ideal for performance but are less portable due to size.

•	 Dynamically expanding disks – expand in size only as data is written. Dynamically expanding 
disks are very portable but have some drawbacks such as fragmentation. Hyper-V provides the 
ability to convert a fixed-size disk to a dynamically expanding disk, and vice-versa. VHD file size can 
be increased, but the VHDs must be taken offline before this can be done. 

•	 Differencing disks – dynamically expanding VHD files that are related to a parent virtual hard disk 
file as an overlay that can be used to create very simple or very complex parent-child hierarchies. 
Each parent and child VHD is stored as an individual file.
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Automatic Differencing Disks
Automatic differencing disks are used to support Hyper-V virtual machine snapshots and are created 
when a virtual machine snapshot is taken.  

Differencing Disk Structure

•	 Similar to a dynamic VHD

•	 Contains associated parent VHD modified disk blocks

•	 Parent VHD read only

•	 Differencing VHD must be modified

•	 Sometimes referred to as a child VHD

•	 Parent VHD can be one of the  three VHD types (dynamic, static, differencing)

•	 Do not modify parent

•	 Keep parent VHD and differencing VHD in same directory on local volume for  
native boot situations

•	 Attaching VHD – not used for native boot so parent VHD can be in different directories, and on a 
different volume or on a remote share

Pass-Through Disks 
Pass-through disks allow virtual machines to access storage mapped directly to the Hyper-V server 
without requiring the volume be configured.  Pass-through disks cannot be dynamically expanded, 
snapshots cannot be taken and differencing disks cannot be used. 

Disk Types

•	 IDE

�� You must use at least one IDE drive for booting

�� 2 IDE controllers with up to 2 devices each

•	 SCSI

�� Are synthetic devices vs. emulated

�� 4 controllers with up to 64 devices each

�� Operates over the VM Bus which is less overhead 

Select Virtual Hard Disk (VHD) Location
Once the type of disk is selected, click Next to specify a name and location for the virtual disk. Any location 
accessible to the host system may be used, or the default location accepted. Click Next to proceed to the 
Configure Disk. Continue through the creation process. Click Finish when completed.
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Modifying Existing Hyper-V Virtual Hard Drives
Modify using the Edit Virtual Hard Disk Wizard. This allows you to convert or expand a VHD.  Hyper-V 
includes Compact, Convert, Expand, Merge, and Reconnect virtual hard disk options.

•	 Compact: decreases size of VHD image file.

•	 Convert: to and from dynamic hard disks.

•	 Expand: increases size of dynamic expandable fixed virtual hard disks.

•	 Merge: merges content from differencing VHD into applicable parent VHD.

•	 Reconnect: Differencing disks must be associated with parent VHD to be able to reconnect.

Figure 20: Example options for editing a fixed VHD.

Creating Virtual Machines (VM)
Hyper-V supports the following Guest operating systems: 

•	 Windows Server 2008 x64/x86

•	 Windows Server 2003 x86/x86

•	 Windows 2000 Advanced Server / Server SP4

•	 Windows HPC Server 2008

•	 Windows Vista x86 (Business, ultimate & Enterprise) SP1 x86/x64

•	 Windows XP Professional SP2/3  x86/x64

•	 SUSE Linux Enterprise Server 10 with SP1/2 x86/x64 Edition

Only SUSE Linux Enterprise Linux is officially supported, but Open SUSE works fine as a Guest OS.
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Add Guest Virtual Machine
The virtual machine wizard is used to configure: Networking, Installation options, Storage Location, 
and VM name.

Storage Location
In the Before you begin wizard introduction window, click Next.  In the Specify Name and Location 
window, enter the name of the Guest Operating System. If the Virtual Machine is not going to be saved in 
the default location then check the box for Store the Virtual Machine in a different location and browse 
and locate the new location. When stored in new location, click Next.

Figure 21: Starting the New VM Wizard

Installation Options
In the Assign memory window, set the memory for the Guest OS and click Next. The Default is 512MB.
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Figure 22: Allocating VM RAM. 
This can be changed later, but the VM must not be running.

In the Configure networking window, select the Virtual Network which should have been created at the 
time of enabling the Hyper-V roles or can be done later on. If choosing to connect to the virtual network 
later, select Not connected and click Next.

In the Connect Virtual Hard Disk window create a new Virtual Hard disk and set its size. The Default is 
127GB. Save the disk in a different location than the defaults that are given as an option. Use a Virtual 
Disk that already exists or choose to attach a Virtual Hard Disk later. When the Virtual Hard Disk (VHD) is 
created, click Next. 
 
In the Installation Options window, choose the media to perform the installation. Choose the installation 
option and click Next. 
 
In the Summary window, check options and click Finish. Choose to Start the Virtual Machine immediately 
after it is created or use the default to keep the VM off.

1.	 In the New Virtual Machine Wizard, choose the method to be used to install  
the operating system. 
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Figure 23: Specifying how the guest VM will be installed. 

�� Install an operating system from a boot CD/DVD-ROM. Use either physical media or an 
image file (.iso file). 

�� Install an operating system from a boot floppy disk. 

�� Install an operating system from a network-based installation server. To use this option, 
configure the virtual machine with a legacy network adapter connected to an external 
virtual network. The external virtual network must have access to the same network as 
the image server.

2.	 Click Finish.

Moving Hyper-V Virtual Hard Disks between IDE and SCSI Disk Controllers 
A VHD assigned to a virtual machine will be attached either to an IDE or a SCSI disk controller, depending 
on the configuration. Sometimes the guest operating system may dictate that the virtual hard disk be 
connected to a different type of disk controller than the one to which it is currently connected. A virtual 
hard disk may also be moved between different disk controllers. 
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Snapshots
Snapshots are ‘point-in-time’ images of each virtual machine. This means that a virtual machine 
can be running and a snapshot can be taken at any point with the ability to revert back to that point, 
including exact memory, virtual hardware, processes, state, etc. 

Snapshots do not change the virtual machine hardware, applications, or the currently running processes. 
Deleting a snapshot does not change the virtual machine however the option to go back to that point to 
rectify a mistake cannot be done.

The snapshot files consist of a copy of the VM configuration .xml file, save state files, and a differencing 
disk which is the new working disk with all child writes prior to taking the snapshot. 

If snapshots are created one after another and a previous snapshot is never applied, the tree will only have 
one branch. If a previous snapshot is applied, another branch is created with the snapshot tree starting at 
the applied snapshot.

Snapshots create a point-in-time copy of a VM and are used for configuration, not as a backup.  

Creating Snapshots
To create a snapshot, in the Hyper-V Manager console highlight the VM, then right-click and select the 
Snapshot menu option. The Hyper-V Manager Snapshots pane displays a tree structure to represents the 
VM snapshot hierarchy. The root node of the tree is the first snapshot that was created. Under the root 
node, there is a child named Now which represents the VM running version. By default, snapshots are 
labeled using the VM name connected with the creation timestamp. In order to rename the snapshot, 
highlight it, then right-click and select Rename from the menu. 

Figure 24: 3 Sequential Hyper-V Snapshots

Revert Option
Use the Revert option to return the VM to the state of the last snapshot that was taken.  The snapshot 
hierarchy view does not change after the Revert was performed because none of the snapshots are 
altered during this operation. However, using the Revert option again will continue to return the VM to the 
configuration and state of the last snapshot taken. 
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Apply Option
To return to a snapshot that is higher than one level up from the running VM (represented by the Now 
marker in the Snapshot pane), highlight the snapshot, right-click, and choose the Apply option from the 
menu. If the snapshot is not taken prior to the Apply operation the running virtual machine configuration 
and state is lost.

Delete Option
Hyper-V provides two different Delete options to permanently remove one or more snapshots from 
the snapshot hierarchy. Deleting a single snapshot will not affect other snapshots, but it will delete 
the configuration file and save state files associated with the snapshot. Deleting a snapshot subtree 
immediately deletes the configuration and save state files associated with all the snapshots in the subtree. 

Microsoft Volume Shadow Copy Service (VSS)
Hyper-V snapshot technology includes the Microsoft Volume Shadow Copy Service (VSS) to make a 
duplicate copy of a file. In virtualization, the file is the entire virtual server guest image. The first time 
a snapshot is taken, the snapshot contains a compressed copy of the contents of RAM on the system 
along with a bitmap of the guest session virtual disk image. If the original guest image is 8GB in size, 
the snapshot will be much smaller in size; however, the server storage system still needs to have additional 
disk space to support the original disk image, plus the amount of disk space needed for the contents of 
the snapshot image.

Storage Considerations 
Window Server 2008 storage options include:

•	 SCSI and IDE – if there are more than four virtual disks to a guest SCSI must be used. If there are  
no guest operating integration components, use IDE to start the virtual disk. Both IDE and SCSI can 
be used with the same virtual machine. For SAN migrations, make sure that the LUN is visible on 
both hosts.

•	 iSCSI – use iSCSI to expose disks directly to the guest operating system. The Hyper-V virtual BIOS 
does not support starting from the iSCSI disk directly. That means at least one IDE disk must be 
available. iSCSI disks can be accessed by the guest OS using the iSCSI initiator Control Panel Applet. 
Using iSCSI requires the Microsoft iSCSI Initiator service to be running.

•	 Pass-through disks – by-pass the Host VHD file to access a disk directly. Use either a Hyper-V 
internal physical disk or a Storage Area Network (SAN) Logical Unit (LUN) mapped to the Hyper-V 
server. Unlike other storage types, pass-through disks are not limited to 2040 GB.

Storage Types
The following physical storage types are available with a server that runs Hyper-V:

•	 Direct-attached storage (storage attached to the management operating system) -  
Use  Serial Advanced Technology Attachment (SATA), external Serial Advanced Technology 
Attachment (eSATA), Parallel Advanced Technology Attachment (PATA), Serial Attached SCSI (SAS), 
SCSI, USB, and Firewire.

•	 Storage area networks (SANs) - use Internet SCSI (iSCSI), Fibre Channel, and SAS technologies.

Network-attached storage (NAS) is not supported for Hyper-V. 
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Storage Configuration Options  
Use either virtual hard disks or physical disks that are attached to the VM on the management operating 
system. Virtual hard disks with a capacity of up to 2040 gigabytes include the following types:

•	 Fixed size VHD occupies physical disk space on the parent operating system equal to the 
maximum size of the disk. 

�� Takes longer to create because its size is allocated when it is created. 

�� Provides improved performance.

�� Recommended for VMs in production environment. 

•	 Dynamically expanding VHD grows as data is written to the disk, providing the most efficient use 
of disk space. 

•	 Differencing - stores the differences from the VHD on the management operating system. 

�� Can be shared with virtual machines

�� Should remain read-only  

Each virtual machine supports storage of up to 512 TB; whereas physical disks that are directly attached to 
a virtual machine have no size limit other than what is supported by the guest operating system. 

VM storage:

•	 Store VM configuration files separately from VHDs to enhance performance.

•	 Disk images (VHD files) should be stored on a separate drive from your host operating system for 
best performance.

•	 Where VHD files are located is important when a failover cluster is being used because the 
configuration file must be accessible by all nodes.

Editing VHDs
The virtual hard disk wizard is used to:

•	 Create disks

•	 Compact disks

•	 Convert disks

•	 Expand disks

•	 Merge disks

•	 Reconnect disks
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Objective Summary
To configure Hyper-V properly, it is important to understand virtual hard disks (VHDs) and the various 
configuration options. There are three VHD types: fixed size, dynamic, and differencing. Fixed-size VHDs 
have a set amount of hard disk space, and that amount does not change. Dynamic VHDs only use the 
amount of space that is currently being used for the VHD. Differencing disks are configured in a parent-
child relationship with another disk that stays intact. 

Shadow copies are included with Hyper-V virtual machines, and they are called virtual machine snapshots. 
Virtual machine snapshots will take a copy of your virtual machine and place that copy in a specified location. 

Pass-through disk access allows Hyper-V to work without VHDs. Virtual machines can access a file system 
directly through the use of this feature. 

Understand virtual hard disks (VHDs). A VHD is a virtual hard drive that the guest operating system is 
installed onto. During the installation of the guest operating system, determine the size and location of 
the virtual hard disk that the virtual machine will use. 

Be able to list the three VHD types. There are three VHD types. Fixed-size VHDs have a set amount of 
hard disk space, and that amount does not change. Dynamic VHDs only use the amount of space that is 
currently being used for the VHD. The fixed-size VHD option offers better performance than the dynamic 
VHDs by eliminating the fragmentation associated with a growing file. Differencing disks are configured in 
a parent-child relationship with another disk that stays intact. This allows changes to the operating system 
or data without affecting the parent disk. 

Be familiar with virtual machine snapshots. Understand that Microsoft Hyper-V has also included 
the shadow copies advantages to your virtual machines and they are called Virtual Machine Snapshots. 
Virtual machine snapshots will take a copy of the virtual machine and place that copy in a specified 
location. Understand the recovery and rollback advantages of using virtual machine snapshots. 

Understand pass-through disk access. Pass-through disk access allows Hyper-V to work without the use 
of virtual hard disks (VHD). Virtual machines can access a file system directly, thus eliminating the need for 
VHDs. Be sure to know that VHDs are inaccessible to non-virtualized systems due to the VHD formatting. 
Pass-through disk access helps solve this problem by allowing the virtual machine to directly access the 
writable file system. Using pass-through disk access allows you to surpass the 2040GB limitation of VHDs. 

Domain 5: Configuring Virtual Machines
Guest OS Components
Before creating the virtual machine, consider the following when using the New Virtual Machine Wizard. 

•	 Installation media (physical media, a remote image server, or an .ISO file) 

•	 Memory allocation

•	 Where the virtual machine will be stored 

•	 Network card usage

•	 Name for the virtual machine 
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Managing Virtual Machines
System Center Virtual Machine Manager (SCVMM) 2008 provides management interface across multiple 
virtualization software environments, including Hyper-V. SCVMM abstracts the differences between 
hypervisor APIs and allows running an action without disturbing the virtual machine software. 

With SCVMM 2008, virtual machines can be created and managed on Hyper-V hosts.  If a host is 
added that is running Windows Server 2008 and it does not have Hyper-V enabled, SCVMM 2008 will 
automatically enable the Hyper-V role on the host. 

Working with Snapshots
Virtual machine snapshots capture the state, data, and hardware configuration of a running virtual 
machine. Virtual machine snapshots are intended mainly for use in development and test environments. 
The ability to revert a virtual machine can be useful in recreating an event or state for troubleshooting 
purposes. In production environments snapshots can provide a way to revert an operation such as a 
software update.   

Snapshot data files, stored as .avhd files, and are normally stored in the same folder as the virtual machine 
by default.

Exceptions:

•	 If virtual machine was imported with snapshots then snapshots are stored in their own folder.  

•	 If virtual machine does not contain any snapshots, a specific folder to store snapshots can be 
named upon configuring the VM snapshot setting.  

Do not delete .avhd files directly from the storage location. Instead, use Hyper-V Manager to select the 
virtual machine, and then delete the snapshots from the snapshot tree.

In production environment keep in mind: 

•	 VM snapshots reduce disk performance.

•	 When a snapshot is deleted, the .avhd files that store the snapshot data remain in the storage 
location until the virtual machine is shut down, turned off, or put into a saved state. Put the 
production virtual machine into one of those states at some point to complete removal. 

•	 It is best not to use snapshots on virtual machines that provide time-sensitive services, or when 
performance or storage space is critical.

Configuring Highly Available Virtual Machines (HAVM)
Highly available virtual machines (HAVMs) can be migrated to a different virtual machine host in a failover 
cluster to provide continuing service when their current host needs maintenance. If their current host fails, 
the HAVMs automatically migrate to a different host in the cluster through a process known as failover. 

System Center Virtual Machine Manager (SCVMM) 2008 supports HAVMs deployed on Windows 
Server 2008 failover clusters. System Center Virtual Machine Manager 2008 R2 supports HAVMs deployed 
on Windows Server 2008 failover clusters or Windows Server 2008 R2 failover clusters. 
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Configure a Highly Available Virtual Machine
If a virtual machine is configured as a highly available virtual machine, SCVMM places the 
virtual machine on the most suitable host in a host cluster. To configure a virtual machine as 
highly available, in the advanced settings on the Configure Hardware page of the New Virtual Machine 
Wizard, display Availability settings, and select Make this virtual machine highly available.

If a virtual machine is not configured for high availability it can become highly available during placement 
because all hosts including clustered hosts will be available.  When a clustered host is chosen, click Yes to 
make the virtual machine highly available. Then, the VM will be deployed on a clustered host and becomes 
highly available.

Virtual Machine Manager places highly available virtual machines only on clustered hosts. Virtual Machine 
Manager places virtual machines that are not highly available only on non-clustered hosts. SCVMM does 
not allow the creation of non-HAVMs on clustered hosts. If such virtual machines are created outside 
SCVMM, they are imported and treated as non-HAVMs, just like virtual machines on non-clustered hosts.

Monitoring Performance
Ensure that Hyper-V Integration Services are installed on both the host and the guest operating systems. 
Hyper-V integration services provide virtual server client (VSC) code for Hyper-V enlightened I/O, 
which increases the performance of operating system functions such as memory management and 
network performance. Run solutions such as; roles, features, or custom services on a Hyper-V virtual 
machine rather than on the host operating system.

Using Perfmon.msc
Because Hyper-V is a kernel-level addition to Server 2008, monitoring Hyper-V performance is a little 
different than monitoring a legacy server. Since the default Hyper-V management console only displays 
CPU usage and RAM allocation, we need to dig deeper to assess Hyper-V performance and troubleshoot 
performance problems. When you install the Hyper-V role, Windows will have several series of counters 
for use with Perfmon.msc. If you monitor Hyper-V using the standard counters, you may not be getting an 
accurate picture of your server’s performance. 

To get an accurate picture of performance of a host partition, you can no longer use the plain old 
“Processor Time” counter, because the Processor Time will include jobs running on virtual machines, 
which will skew your assessment of host partition performance. Host partition performance is most 
accurately viewed by using the counters underneath the “Hyper-V Hypervisor Root Partition Virtual 
Processor”. Since the host partition handles IO for the guests, a high CPU usage on the host partition 
may indicate an IO issue in one of the guests.

Useful counters include:

•	 Health Counters – the counters under “Hyper-V Virtual Machine Health Summary” can provide 
you with a glance of which VMs need attention. If you are not using SCVMM or some other 
monitoring software, you could configure Events which occur when these numbers drop below a 
certain value, indicating VM trouble.

•	 CPU Utilization – monitoring the “Processor” counters from the parent partition will give  
you an accurate view of the physical processor usage on a Hyper-V host. The values will be the 
aggregate of the parent partition + the child partitions. The “Hv LP” values are Logical Processes, 
which is the device Hyper-V uses for interrupts to the physical system. If you are not running with 
Integration Services installed, you may see the CPU Utilization stay consistently at a value higher 
than it should be.
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•	 Interrupts/Second – although CPU usage may be low, a Hyper-V server may have to process 
a large number of interrupts for both hosts and guests. How many interrupts a CPU can 
handle is large dependent on the architecture, but this counter may be a starting point when 
troubleshooting a slow Hyper-V server when other counters are within acceptable ranges.

•	 Network Utilization – network utilization is available in the Hyper-V Virtual Network Adapter 
Bytes Received/Sec and Bytes Sent/Sec. This will include all enlightened guests and guests with 
synthetic network adapters installed through integration services. Hyper-V Legacy Network 
Adapter Bytes Received/Sec and Sent/Sec. will show the throughput for all synthetic network 
adapters. “Virtual Switch” monitors can be helpful to know how much traffic is being sent between 
VMs on Internal networks.

•	 Disk Utilization – disk utilization can either be monitored by looking at the virtual IDE or SCSI 
adapter installed on an individual VM, or it can be monitored by VHD file (using the “Hyper-V 
Virtual Storage Device” counters. “Physical Disk” will give you the overall system disk performance. 
Typically we are looking at “Disk Bytes/Sec”, but we can also see bottlenecks if a lot of IO operations 
are waiting in the queue. This can be determined by looking at the “Current Disk Queue Length”, 
which should be about 2 operations per drive.

•	 Memory Utilization – Hyper-V cannot oversubscribe RAM to guests. Each guest must stay 
resident in memory, as paging the running guest images to disk is not allowed. Therefore,  
the RAM counters in Perfmon are accurate and include all partitions. The TLB is the Translation 
Lookaside Buffer and is a processor technology that is required for mapping Hyper-V guest RAM 
to physical RAM. A high number of TLB If your “Hyper-V Hypervisor Partition/Virtual TLB Flush 
Entries/Sec” is high, consider upgrading processors to a newer processor supporting Second-Level 
Address Translation (SLAT) and moving to Server 2008 R2. SLAT was designed to help address 
memory translation problems in hardware and is one of the advantages of using Hyper-V on 
Server 2008 R2.

Figure 25: Hyper-V performance can be monitored, if you know what to look for
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Optimize Disk Performance

•	 For best performance of the SQL Server subsystem running in a Hyper-V virtual machine,  
configure the disks used by SQL Server as “pass-through” disks in the Hyper-V Manager.  
Pass-through disks are physical disks/LUNs attached to a virtual machine that do support  
some of the functionality of virtual disks, such as Virtual Machine Snapshots.

•	 Ensure Hyper-V data file optimal disk I/O by installing integration services on both the  
host and guest operating system. Then configure pass-through disks for data volumes with  
the SCSI controller.

•	 Do not attach a system disk to a SCSI controller. A virtual hard disk that contains an operating 
system must be attached to an IDE controller.

Optimize Memory Performance

•	 Ensure there is sufficient memory installed on the physical computer that hosts the Hyper-V  
virtual machines. Each virtual machine must reside in non-paged-pool memory, or memory that 
cannot be paged to the disk. This creates the need to have enough memory on the physical 
computer that hosts the virtual machines equal to the sum of the memory allocated for each 
virtual machine plus 300 MB for the Hypervisor, 32MB for the first GB of RAM for each VM,  
another 8MB for each additional GB of RAM for each VM, plus 512 MB for the host operating 
system running the root partition. 

•	 If possible use a 64-bit operating system for each guest operating system to take advantage of the 
memory installed on the physical computer that hosts the Hyper-V virtual machines.

Optimize Network Performance
Configure guest operating systems to use a Network Adapter rather than a Legacy Network Adapter. 

Optimize Processor Performance

•	 CPU intensive application configuration is a 1-to-1 mapping of virtual processors in the guest 
operating system to the host operating system available logical processors. Configuration such as 
2:1 or 1:2 is less efficient. 

•	 The hosted application’s performance can be affected by the number of processor cores available 
to the guest operating system running in a Hyper-V virtual machine. Therefore, consider carefully 
which operating system will be installed in the Hyper-V virtual machine. 

Virtual Machine Settings
Some of the VM settings:

•	 BIOS boot order

•	 Processor settings (virtual processors)

•	 Configure reserve/limit percentage 

•	 Amount of memory allocated to the VM

Peripheral and Integration Settings:

•	 Server settings that specify the virtual machine(s) and virtual hard disk(s) locations and settings

•	 User settings which allow customized interactions with VM connections (mouse release key and 
Windows keys), and display messages and wizard pages  
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Configure Hyper-V settings 

1.	 Open Hyper-V Manager. 

2.	 Click Start.

3.	 Point to Administrative Tools.

4.	 Click Hyper-V Manager.

5.	 In the Actions pane, click Hyper-V Settings.

6.	 In the Navigation pane, click the setting to be configured.

7.	 Click OK to save the changes and close Hyper-V Settings or click Apply to save the changes 
and configure other settings.

Note: Must be a member of the local Administrator group or use the Authorization Manager to modify 
the authorization policy to include user(s) or group(s) authorized to perform these tasks. 

Adding IDE or SCSI devices 

•	 IDE devices – Hyper-V uses devices with IDE controllers; up to two IDE controllers Hyper-V with 
two disks on each controller. The startup disk can be either a virtual hard disk or a physical disk 
(boot disk) must be attached to one of the IDE devices. 

•	 SCSI devices – each virtual machine supports up to 256 SCSI disks (four SCSI controllers with each 
controller supporting up to 64 disks). SCSI controllers use a type of device developed specifically 
for use with virtual machines and use the virtual machine bus to communicate. The virtual 
machine bus must be available when the guest operating system is started. This means that SCSI 
controllers cannot be used as startup disks.

Adding Adapters 
Multiple Adapters can be added to Hyper-V.  If using a failover cluster, they must be marked as  
“Certified for Windows Server 2008.” If using iSCSI, network adapters should be dedicated to either 
network communication or iSCSI, not both. Connect cluster nodes by multiple, distinct networks or with 
one network that is constructed with teamed network adapters, redundant switches, redundant routers,  
or similar hardware that removes single points of failure.  

1.	 Go to Administrative Tools.  

2.	 Click Hyper-V Manager. 

3.	 In the results pane, under Virtual Machines, select the virtual machine to be configured.

4.	 In the Action pane, under the virtual machine name, click Settings.

5.	 In the Navigation pane, click Add Hardware.

6.	 On the Add Hardware page, choose a network adapter or a legacy network adapter. 

Note: can be added only when virtual machine is turned off.  

1.	 Click Add. The Network Adapter or Legacy Network Adapter page appears.

2.	 Under Network, select the virtual network to connect to. 
If configuring a static MAC address or virtual LAN identifier, specify the address or identifier  
to be used.

3.	 Click OK.
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Modify virtual machine settings 

1.	 In the Failover Cluster Manager snap-in, if the cluster to be configured is not displayed, in the 
console tree, right-click Failover Cluster Manager.

2.	 Click Manage a Cluster, and then select the cluster to be configured.

3.	 If the console tree is collapsed, expand the tree under the cluster to be configured.

4.	 Expand Services and Applications.

5.	 Click FailoverTest. 

6.	 In the center pane, right-click the virtual machine resource, and then click Settings. (If Settings 
does not display, collapse the virtual machine resource and then right-click it.)

7.	 Configure the settings for the virtual machine.

Start/Stop Actions - configured to control the virtual machine when the Host is stopped.

•	 Automatic Start Action - defines VM actions that should be taken when the host system boots; 
not starting the virtual machine, starting the virtual machine or only starting the virtual machine 
if it was running when the host last shut down or to delay the start up by a specified number 
of seconds. This delay prevents all virtual machines starting at the same time and allows critical 
virtual machines to start before less critical ones.

•	 Automatic Stop Action - defines VM actions that should be taken when the host system 
shuts down, including; powering off the virtual machine, saving the virtual machine state and 
performing guest operating system shutdown. Guest operating shutdown requires the Hyper-V 
Integration Services installation on the guest and the Operating Shutdown Control option 
supported and enabled. 

Live Backups - Enable VSS integration   

1.	 Use the backup software (VSS requestor) to start the backup (creation of a shadow copy). 

2.	 Hyper-V services forwards a backup request to all VM’s. 

3.	 The software in the VM’s SQL/Exchange (VSS writer) “pauses”.

4.	 The SAN hardware (VSS provider) creates a snapshot of the data.  

5.	 Hyper-V services are notified the shadow copy is done and OK.

6.	 The backup software (VSS requester) tells you that the shadow copy was successfully created.

Managing Snapshots
Creating a Snapshot

1.	 Highlight the VM.

2.	 Right-click and select the Snapshot menu option. The Snapshot pane displays with  
a tree structure.

3.	 Root node is the first snapshot that was created.

4.	 Under root is child named Now (current running version).

5.	 Highlight snapshot.

6.	 Right-click, select Rename from menu. 

Applying a Snapshot
To return to a snapshot that is higher than one level up from the running VM (represented by the Now 
marker in the Snapshot pane), highlight the snapshot, right-click, and choose the Apply option from the 
menu. If the snapshot is not taken prior to the Apply operation the running virtual machine configuration 
and state is lost.
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Deleting a Snapshot
Deleting a single snapshot does not affect other snapshots, but it does delete the configuration file and 
save state files associated with the snapshot.  
 
Deleting a Sub-tree
Deleting a snapshot sub-tree immediately deletes the configuration and save state files associated with 
all the snapshots in the sub-tree. If the running virtual machine AVHD is not a child of any snapshot in the 
sub-tree, then all of the AVHDs in the sub-tree will also be deleted.  

Reverting
Using the Revert option allows you to return the VM to the state of the last snapshot that was taken. 
The last object in the hierarchy, marked by Now, indicates the running VM.

Configure Memory or Processors for a Virtual Machine
Virtual machines consume memory only when they are running or paused. If the physical computer has 
multiple processors and uses non-uniform memory architecture (NUMA), it is recommended that a VM is 
not assigned more processors or memory than are available on a single NUMA node. 

Configure Virtual Machine Memory or Processor

1.	 Open Hyper-V Manager. 

2.	 Click Start.  

3.	 Point to Administrative Tools.  

4.	 Click Hyper-V Manager. 

5.	 In the Results pane, under Virtual Machines, select the virtual machine that you  
want to configure.

6.	 In the Action pane, under the virtual machine name, click Settings. 

7.	 In the Navigation pane, click the appropriate hardware setting:

•	 To configure the memory, click Memory. On the Memory page, specify the new  
amount of memory.

•	 To configure the processor, click Processor. If multiple processors are supported by the guest 
operating system, specify the number of processors to assign to the virtual machine. Click OK.

Configure Resource Allocation for a Virtual Machine
Hyper-V contains the following resource controls: 

•	 Virtual machine reserve specifies the percentage that is reserved for the virtual machine.

•	 Virtual machine limit specifies the maximum percentage that can be used by the virtual machine. 

•	 Relative weight specifies how Hyper-V allocates resources to this virtual machine when more than 
one virtual machine is running and the virtual machines compete for resources. 
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Configure VM Resource Allocation   

1.	 Open Hyper-V Manager. Click Start.

2.	 Point to Administrative Tools.

3.	 Click Hyper-V Manager. 

4.	 In the Results pane, under Virtual Machines, select the virtual machine to be configured. 

5.	 In the Action pane, under the virtual machine name, click Settings.

6.	 In the Navigation pane, click Processor.

7.	 Under Resource control, specify the amount for each control you want to use. Click OK.

Memory Usage
Allocate memory so there is at least a 2 GB difference between the sum total of the memory being used 
by all virtual machines and the total amount of memory that is installed in the server. Hyper-V should 
be the only server role that is installed. Additional roles should be installed in a guest operating system. 
Multiple network cards can be installed in the server, and a different NIC can then be assigned to each 
virtual server instance. If possible have a NIC for the host operating system, and a dedicated NIC for each 
guest operating system. When assigning NICs remember that some virtual machines will receive more 
traffic than others. Hyper-V is able to reallocate NIC usage at a later time if necessary. Switching NICs 
requires a virtual machine shut down. 

Microsoft Offline Virtual Machine Servicing Tool
Although bringing up new virtual machines in Hyper-V using SCVMM, PowerShell, or some manual 
method can make server deployment much more effective than installation from an imaging server, it can 
be problematic if a source VHD file hasn’t been turned on for a while to get updates. Deployment of new 
servers can slow to a crawl and security holes can be introduced into your environment as out-of-date 
VMs are booted up for the first time. Although the source VMs could be booted occasionally for updates 
(or even automatically with a scheduled PowerShell task), Microsoft has released a tool called the Offline 
Virtual Machine Servicing Tool that will automatically deploy your offline VHD images to a host, start them 
and trigger a software update, and shuts down the VMs. They are then placed back in the library. 
It can also update the antivirus instance that lives in the offline VM so it has up-to-date definitions when 
it is deployed into production. The Offline VM Servicing tool requires SCVMM, WSUS 3.0 SP1 or later, and 
System Center Configuration Manager 2007 or later.

Domain 6: Conversion of Systems to Hyper-V
Hyper-V Conversion Overview
Hyper-V role conversion moves the operating system, files, and associated settings from a physical or 
virtual system to Hyper-V. To move a Hyper-V image from one system to another, use the Export function 
in the Hyper-V management tool. The Export function captures the majority of the Hyper-V settings 
that are required for migration, including configurations, networks, and hard disks. The DCOM and WMI 
namespace security settings must be migrated separately. Turn off or remove the source server from the 
network before running the import function on the destination server. 

Conversion may impact any computer that relies on the applications or workloads running in the virtual 
machines to be converted because the virtual machines will be offline for the duration of the conversion. 
If a virtual machine hosts a database, any applications that require access to that database will be 
impacted. Plan accordingly for this downtime. The user account that runs the cmdlets and tools must be a 
local Administrators group member on the source and the destination servers. Conversion time is affected 
by the size of the source data, host server load, and network bandwidth.
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Moving Between Hyper-V Hosts
Exporting a Hyper-V Virtual Machine 

1.	 Launch the Hyper-V Manager console (Start → Administration Tools → Hyper-V Manager). 

2.	 Ensure virtual machine to be exported is either powered off or in a saved state:

•	 Select VM from the list. 

•	 Select the appropriate action from the Actions panel. 

3.	 Once the virtual machine is powered off or saved, click on the Export action link to display the 
Export Virtual Machine dialog.

4.	 In the Export Virtual Machine dialogue, enter the target location or use the Browse button. 
Location must have sufficient free space to store the virtual machine configuration, virtual hard 
drives and snapshots. 

5.	 If only the configuration files for the virtual machine are to be exported, select the Export only 
virtual machine configuration option. Within the designated location, a sub-folder with the VM 
name will be created to contain the exported data. 

6.	 Click on the Export button. 

7.	 Once the Hyper-V Manager indicates that the export process has completed, use Windows 
Explorer to navigate to the specified export location and review the files that have been created. 

When a virtual machine has been exported, the following files and folders are created in the specified 
export location: 

•	 config.xml - contains the Virtual Machine basic configuration information in XML format. 
Information includes original VHD locations assigned to the virtual machine and some state 
information. If the Export only virtual machine configuration option was selected during the export 
process this is the only file which will be present in the folder. 

•	 Virtual Machines - The file contained within this folder is named using a combination of the 
virtual machine’s globally unique identifier (GUID) and the .exp file extension. This file contains 
the detailed virtual machine configuration and is in binary format. When imported into the target 
Hyper-V server the information is converted to XML format. 

•	 Virtual Hard Drives - This folder contains copies of any virtual hard drive file images associated 
with the exported virtual machine. 

•	 Snapshot - Contains all snapshot data associated with the exported virtual machine including 
configuration files, saved state file, differencing disk image files and the memory image file. 

If the option to export only the virtual machine configuration was selected, only the config.xml file and the 
.exp file in the Virtual Machines folder will be exported. ‘

Importing a Hyper-V Virtual Machine 

1.	 Upon successful exporting, import the virtual machine into the target Hyper-V Server.

2.	 Transfer the files to the target system. 

3.	 Launch the Hyper-V Manager (Start → Administration Tools → Hyper-V Manager) and click 
on the Import Virtual Machine link in the Actions panel. 

4.	 Once the virtual machine has been imported, the folder cannot be used to import a second time. 
The new virtual machine will be using the folder for the imported virtual machine. 

5.	 When the import is completed the dialog closes and the virtual machine is ready to run.  
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Integration Components 
Install Integration Services 

1.	 From the Virtual Machines section of the results pane, right-click the name of  
the virtual machine. 

2.	 Click Connect. The Virtual Machine Connection tool will open.

3.	 From the Action menu in the Virtual Machine Connection window, click Start.

4.	 Proceed through the installation. 

Import/Export
Consider the following before using import/export to migrate between servers:

•	 A virtual machine can only be exported if it is shut down or saved. A running or paused virtual 
machine cannot be exported.   

•	 The set of files comprising an exported virtual machine may only be imported once into a  
Hyper-V server. If an exported virtual machine is to be imported into multiple Hyper-V servers, 
separate copies of the export folder will need to be used for each import. 

•	 The Hyper-V Import feature is only able to import Hyper-V based virtual machines.  
The configuration format used by Virtual Server 2005 and Virtual PC is incompatible with  
that used by Hyper-V in this context. 

•	 In addition to virtual machine configuration and virtual disk image files, the Import/Export process 
will also transfer any existing snapshots for the virtual machine. 

Managing VMware
System Center Virtual Machine Manager (SCVMM) controls virtualized environments with the use of 
a single console and automates tasks by using one Windows PowerShell interface across multiple 
hypervisors. SCVMM uses the API interface exposed by the VMware VirtualCenter server to manage 
VMware ESX Server hosts. For ESX Server-specific management, such as creating or removing resource 
pools and patching ESX Server computers, use VirtualCenter. Use SCVMM for tasks such as: managing, 
creating, placing, deploying, and removing virtual machines and adding or removing hosts.

VMware Support
SCVMM supports the VMware ESX hypervisor and VMware VirtualCenter, including the following:

•	 VMware ESX Server 3.0 or above, and VMware ESX Server 3.5i 

•	 VMware VirtualCenter (VC) 2.5 (VMware Infrastructure 3 [VI3]) 

•	 VMware vSphere 4 (VI3 features only)

SCVMM does not support VMware Server.

VirtualCenter 
SCVMM operates with VMware by connecting to the VirtualCenter server through Web service calls.  
A SCVMM agent is not required on the VirtualCenter server or on the ESX Server hosts. The SCVMM server 
periodically refreshes VMware environment information and maps it to SCVMM. VirtualCenter server is 
required for SCVMM to manage ESX Server hosts. SCVMM contacts the ESX Server hosts directly using 
Secure FTP (SFTP) or HTTPS to transfer data between ESX Server hosts and Windows Server computers. 
SCVMM uses VirtualCenter to access VMotion functionality.  
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Organize and store VMware virtual machines, VMDK files, and VMware templates in the SCVMM Library. 
SCVMM supports creating new virtual machines from templates and converting stored VMware  
virtual machines to Hyper-V. Use the Import templates action, available in Administration view  
of the SCVMM Administrator Console when the Virtualization Managers node is displayed.  
Supported templates include:

•	 Customized templates require an operating system profile to automate deployment. 

•	 Non-customized templates do not have an operating system profile attached, used for operating 
systems that cannot be customized. 

VirtualCenter PowerShell Automation  
VirtualCenter daily administration tasks can be done through SCVMM PowerShell or through the SCVMM 
Administrator Console. 

Examples include:

•	 Start

•	 Stop

•	 Pause

•	 Checkpoint

•	 Migrate

•	 VMotion

•	 Add-remove properties

•	 Add-remove hardware settings

•	 View live console 

•	 Expose through Self-Service

VMware Support for Highly Available Virtual Machines

•	 HA (High Availability) – used for fast recovery. 

•	 VMotion – SCVMM supports VMware VMotion through VMware VirtualCenter.

•	 Migrate storage – SCVMM 2008 R2 uses Storage vMotion when it moves virtual machine 
configuration files and virtual disk files on a running virtual machine from one independent 
storage location to another on an ESX Server host. 

•	 PRO – SCVMM uses PRO to enable dynamic load-balancing using VMotion. 

VMware Hosts in Maintenance Mode
When an ESX Server host is placed in maintenance mode, SCVMM automatically makes that host 
unavailable for placement in SCVMM. To make available for placement in SCVMM, must remove the host 
from maintenance mode by using the VMware VirtualCenter console. 
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Adding a VMware Infrastructure to SCVMM
Add the VirtualCenter Server
To integrate a VMware infrastructure into your SCVMM-managed virtualized environment, 
begin by adding your VMware VirtualCenter server to SCVMM. When a VirtualCenter server is added, 
SCVMM discovers all VMware ESX Server hosts and clusters that the VirtualCenter server is managing and 
adds the objects to SCVMM.

To add the VirtualCenter server, use the Add VMware VirtualCenter Server action, available in all views of 
the SCVMM Administrator Console. Appropriate VirtualCenter administrator credentials must be provided 
to perform this action. 

Newly created ESX Server hosts initially have OK (Limited) status. To be able to perform all management 
tasks that SCVMM supports, enter credentials with appropriate authority in the host properties. 
If managing the VMware environment in secure mode; retrieve and accept a security certificate and, 
in some cases, a public key. The security information for an ESX Server host is specified on the Security tab 
of the host properties.

In secure mode, SCVMM authenticates each ESX Server host: 

•	 Secure Sockets Layer (SSL) over HTTPS for embedded ESX Server

•	 VMware ESX Server 3i and later requires certificate authentication

•	  SFTP over Secure Shell (SSH) for non-embedded ESX Server

•	 VMware ESX Server 3.5

•	 VMware® ESX Server 3.0.2

For non-embedded versions of ESX Server the SSH public keys need to be added to the SCVMM database. 
Validate the public key when security for individual hosts in VMM is configured or use a script to update 
the SCVMM database with public keys for all of non-embedded ESX Server hosts. When VirtualCenter 
server is added to SCVMM, SCVMM turns on secure mode by default. If this level of authentication is not 
required, turn off secure mode.

SCVMM must have access to virtual machine files on the host to perform file transfer operations 
between hosts running non-embedded versions of ESX Server and Windows-Server-based computers, 
(i.e., creating a virtual machine with a virtual hard disk stored on a SCVMM library server or storing a 
VMware virtual machine in the SCVMM library).

Use Import Templates action to import your VMware templates to the SCVMM library so they can be used 
to create virtual machines in SCVMM. 

Converting VMware to Hyper-V
Convert a VMware virtual machine to a Hyper-V virtual machine using one of these two methods:

•	 Offline Conversion (V2V) – use the Convert Virtual Machine Wizard to perform a virtual-to-virtual 
conversion (V2V), which takes a set of VMware files that compose a virtual server and converts 
them into a Hyper-V compatible guest. 

•	 Online Conversion (P2V) – use the Convert Physical Server Wizard to perform a physical-to-
virtual machine conversion on the running guest operating system on VMware, as if the VMware 
guest was a physical machine. 
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Conversion of VMware Images
V2V is the most reliable way to ensure data consistency because it creates an exact copy of the source 
VMware images while they are not in use. 

To complete a V2V conversion in SCVMM, follow these steps:

1.	 Turn off the VMware virtual machine. 

2.	 VMware virtual machines can be stored in the library by copying the VMDK and VMfiles into the 
library share. The library share will take a while to update (or you can refresh it manually by right-
clicking it).

3.	 Start the Convert Virtual Machine Wizard from the SCVMM hosts pane. 

4.	 You will be prompted to select the source VM from the library (See below).

Figure 26: Selecting a non-Hyper-V VM to convert from the library.

5.	 Click Next to proceed through the wizard; you will have to specify all of the standard settings for 
creating a VM, including the number of CPUs and RAM.

6.	 Choose a host to place the converted Hyper-V VM on. A summary of your hosts will be presented 
(see below).
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Figure 27: Setting a destination for a V2V Conversion.

7.	 Select the network settings and additional options, such as how the VM should shut down  
when the host shuts down and if the VM should be started automatically when the conversion 
process finishes.

8.	 SCVMM executes the conversion process and places a detailed description of its steps in the 
Jobs tab, as seen in Figure 28.

9.	 SCVMM will automatically boot and install Integration Services after the job finishes. It will also 
update the hardware in the HAL, which will require at least one additional reboot.
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Figure 28: An SCVMM V2V conversion job in progress.

Before Hyper-V starts the V2V job, it will give you the PowerShell code that it uses, which will look 
something like this:
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# --------------------------------------------------------------------
----------
# Convert Virtual Machine Wizard Script
# --------------------------------------------------------------------
----------
# Script generated on Friday, April 23, 2010 6:37:39 PM by Virtual 
Machine Manager
# 
# For additional help on cmdlet usage, type get-help <cmdlet name>
# --------------------------------------------------------------------
----------
$VMHost = Get-VMHost -VMMServer localhost | where {$_.Name -eq 
“cluster20.lab.local”}
$VM = Get-VM -VMMServer localhost -Name “XP Pro 32” | where {$_.
LibraryServer.Name -eq “SCVMM.lab.local”} | where {$_.Location -eq “\\
SCVMM.lab.local\MSSCVMMLibrary\Virtual Machines\XP Pro 32”}
$VirtualNetwork = Get-VirtualNetwork -VMMServer localhost | where {$_.
ID -eq “83f206ea-5078-4631-a2b7-8c925d5fa86e”}
$VirtualNetworkAdapter = Get-VirtualNetworkAdapter -VMMServer localhost 
-All | where {$_.ID -eq “1903d2f4-22ef-4dba-903e-dd44d83a2d40”}
New-V2V -VMMServer localhost -VMHost $VMHost -RunAsynchronously 
-JobGroup 5a7f16ca-fdea-47cd-a56b-1420fde02fc9 -VM $VM -VirtualNetwork 
$VirtualNetwork -VirtualNetworkAdapter $VirtualNetworkAdapter 
-NetworkLocation “” -NetworkTag “” 
$VM = Get-VM -VMMServer localhost -Name “XP Pro 32” | where {$_.
LibraryServer.Name -eq “SCVMM.lab.local”} | where {$_.Location -eq “\\
SCVMM.lab.local\MSSCVMMLibrary\Virtual Machines\XP Pro 32”}
$VMHost = Get-VMHost -VMMServer localhost | where {$_.Name -eq 
“cluster20.lab.local”}
New-V2V -VM $VM -VMHost $VMHost -Path “C:\ProgramData\Microsoft\
Windows\Hyper-V” -Name “XP Pro 32” -Description “” -Owner “LAB\
administrator” -RunAsynchronously -JobGroup 5a7f16ca-fdea-47cd-
a56b-1420fde02fc9 -Trigger -CPUCount 1 -MemoryMB 512 -RunAsSystem 
-StartAction NeverAutoTurnOnVM -StopAction SaveVM

If your company is moving from VMWare or Virtual Server 2005 to Hyper-V, you may have many VMs to 
migrate. To automate this process, you can script a VM to VM Conversion in PowerShell with the code 
SCVMM generates.

OS Activation – Reuse Original Product Key
Windows Server 2003 has only one product key. If Windows Server 2008 was obtained from an OEM or as 
an FPP, two keys (product key and virtual key) were included to activate the software. The product key is 
a 25-character key. Use this key when Windows Server 2008 is not running on any virtualization software 
or on a hypervisor layer. Use the virtual key to move instances of Windows Server 2008 from one virtual 
environment to another without the need to reactivate. 
 
If the server came from an OEM with Windows Server 2008 preinstalled use a product key to reactivate if 
the server hardware configuration on which Windows Server 2008 is running has been greatly changed. 
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Virtual key
The virtual key (virtual product key) is a 25-character key. Use the virtual key for the following functions:

•	 Create and store Windows Server 2008 instances (depending on the edition).

•	 Run multiple instances of Windows Server 2008 in Hyper-V at the same time. 

Converting Physical Machines to Hyper-V
There are two ways (online and offline) to convert a physical machine to a Hyper-V virtual machine. 
This section will cover each.

Online Conversion
An online conversion is done while the source computer is operating. After scanning the source machine’s 
hardware and software configuration (for permissions, Service Pack level, and VSS availability), SCVMM will 
install an Agent to the source machine. During the conversion, the agent sends disk images of the physical 
machine’s fixed disks to new VHD files using BITS over HTTPS. After copying the files and creating the new 
XML configurations and VHD files, SCVMM removes the agent from the source computer and installs the 
integration tools on the new virtual machine (if necessary).

The following steps will use the P2V online conversion wizard to convert a physical machine to  
a virtual machine:

1.	 Clicking the “Convert Physical Server” action starts the wizard. 

2.	 The wizard asks for the IP or hostname of the source system and credentials. You should be a 
local administrator on the source system. The wizard will also ask you to identify the destination 
virtual machine name and owner.

3.	 SCVMM scans the system using WMI to detect what hardware the physical system has,  
and determines how it should bring that hardware in to the virtual realm.
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Figure 29: During an online conversion, SCVMM scans the systems hardware using WMI

1.	 Select the source volumes that you want to duplicate virtually and select if you want the 
destination VHD to be fixed or dynamic. At this step, you can also dynamically adjust the  
volume size.

2.	 Specify the number of processors and RAM allocation of the destination VM.

3.	 Select the host Hyper-V server & file destination where SCVMM should place the  
converted machine.

4.	 Configure the virtual network. Available options here depend on which host you have selected 
for placement.

5.	 Additional VM options, such as power-on and power-off behaviors can be defined in the wizard.

6.	 Finally, SCVMM will analyze the conversion wizard results and report if there are any errors that 
will prevent conversion.

SCVMM will perform the conversion and place the new VM on the selected host (Figure 30). Like all 
Hyper-V Jobs, the results are available on the Jobs tab. Hyper-V breaks the job into subtasks so you can 
watch the progress and determine which steps, if any, there are problems at. Hyper-V will also give you the 
PowerShell commands it generates to execute the job.
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Figure 30: Online P2V in progress.

Offline Conversion
Offline P2V is also the only option for converting Windows 2000 Server, and non-NTFS volumes. The main 
reason for this is because these systems do not support Volume Snap Shots. Domain Controllers should 
also be converted offline to ensure Active Directory replications are not lost. Unlike online conversions,  
the user must provide any missing drivers if Windows PE does not support the source computer. The files 
to be converted must be added to the SCVMM Library.

Offline conversion includes:

1.	 Virtual Machine Manager installs the SCVMM agent on the source computer.

2.	 The SCVMM agent installs a Windows PE image on the source computer, modifies the  
boot record, and restarts in Windows PE instead of the base operating system.

3.	 SCVMM begins streaming physical disks. There are no snapshots in this process.

4.	 Continue the process much like the Fix-Up phase and Create Virtual Machine Phase in  
an online P2V.
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Common Conversion Issues

1.	 Do not convert if the VM is not compatible with Hyper-V integration services. Ensure that the 
operating system is up to date with all required software updates and hotfixes. If running 
Windows Server 2003, upgrade to Windows Server 2003 Service Pack 2 (SP2). Uninstall Virtual 
Machine Additions version 13.813 (if converting from VMWare) and later after the virtual 
machine is converted to Hyper-V. 

2.	 Prior to conversion, if the virtual machine was running on Virtual Server 2005 and using a shared 
SCSI bus as part of a test or development cluster, break the cluster, migrate one node, and move 
it to an alternate form of shared storage such as iSCSI.

3.	 Check hardware abstraction layer (HAL) compatibility. By default, Hyper-V installs an APIC 
MP HAL when integration services are installed on the virtual machine. If moving the virtual 
machine to Hyper-V while it has a different HAL, there will be a prompt to upgrade when 
installation of integration service begins. If needed, change the HAL before virtual hard  
disk migration.

4.	 Each host computer minimum hardware requirements include: 

•	 2.0 GHz Minimum CPU speed.

•	 Intel VT or AMD-V Processor Extensions.

•	 DEP (Data Execution Protection, also known as the “No Execute” bit).

•	 512 MB - additional memory needed for each guest operating system, and required available 
hard-disk space of 2 GB on each node. 

Domain 7: System Center Virtual  
Machine Manager (SCVMM)
System Center Virtual Machine Manager Overview
Although we have already touched on SCVMM in our conversion chapter, we will take a deeper look 
at it. SCVMM is a software tool for provisioning, managing, and storing VMs for hardware virtualization. 
SCVMM provides management of physical and virtual machines, virtual infrastructure Performance and 
Resource Optimization (PRO), consolidation of underutilized physical servers, and rapid provisioning 
of new virtual machines. SCVMM also provides optimal data center resources and expertise and rapid 
provisioning and agility. 

SCVMM Benefits
•	 Tightly integrates with Server 2008, offering high performance, enhanced security, high availability, 

scalability, and more. SCVMM uses a console that streamlines many virtualized infrastructure tasks. 

•	 Can manage traditional physical servers and virtual resources in a single console. 

•	 Manages VMware ESX virtualized infrastructure along with the Virtual Center in one tool.

•	 Compatibility with VMware VI3 through Virtual Center allows support of features such as VMotion 
and to provide SCVMM-specific features like Intelligent Placement to VMware servers.

•	 Performance and Resource Optimization (PRO) creates a dynamic IT environment, automatically 
reallocating virtual machine workloads based on resource utilization and available capacity. 
Supports queuing live migrations by defining multiple live migrations and running them one after 
another in sequence without waiting for the current live migration to complete. 
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•	 P2V and V2V Conversions.

•	 Intelligent placement is the ability to optimize management.

•	 Central Library for components.

•	 Works with Powershell to provide management and scripting environment. This version adds more 
PowerShell cmdlets and “view script” controls. 

•	 Consolidation - SCVMM can assess and then consolidate suitable server workloads onto virtual 
machine host infrastructure to free up physical resources for repurposing or hardware retirement.  

SCVMM Components
The Single Computer column shows which operating systems are supported for installing all SCVMM 
components on a single computer. This includes the SCVMM Server, SCVMM database, SCVMM library, 
SCVMM Administrator Console, and, optionally, the SCVMM Self-Service Portal. To manage a Hyper-V host 
that is running Windows Server 2008 R2, SCVMM 2008 R2 must be used.

Installing SCVMM
The SCVMM Installer comes with 6 main features to install:

•	 The SCVMM Server – this is the brains behind SCVMM. Every SCVMM network needs at least  
one of these.

•	 The SCVMM Administration Console – this is the SCVMM administration tool. It can be used to 
manage remote SCVMM Server installations from a local system.

•	 The SCVMM Self-Service Web Portal – this is the web portal that allows your administrators to 
manage their own virtual machines. 

•	 The Local Agent – this agent is installed on Hyper-V servers that are going to be  
managed by SCVMM.

•	 The Operations Manager Configuration Tool – this item provides integration APIs with Systems 
Center Operations Manager (SCOM).

•	 Pre-requisites – this includes SQL Server 2005 Express and Windows Automated Installation Kit 
(AIK), which aides in deployment of VMs.

Of these features, the Self-Service Web Portal, Local Agent, and Operations Manager Configuration Tool are 
optional installs. The Local Agent will be pushed out to Hyper-V servers that you manage.
SCVMM has several hardware and software requirements that must be met:

•	 64 bit Architecture - 2.0GHz or better

•	 2GB RAM

•	 200 GB Hard drive space
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Software

•	 Server 2008 with Hyper-V

•	 .NET 2.0 & 3.0

•	 SQL Server

•	 Powershell 1.0

•	 Windows Remote Management (WinRM)

•	 IIS 7 (For Self-Service Portal only)  including:

�� IIS 6 WMI Compatibility Component

�� IIS 6 Metabase Compatibility function

�� ASP.NET

The Hyper-V role does not need to be installed on the SCVMM server, and SCVMM can be run from a VM 
and manage its own host. The SCVMM machine should, however, be a member of the domain.

When installing SCVMM, setup will prompt you for a SQL server (Figure 31), as this is how SCVMM stores 
data and creates reports. SCVMM will also prompt for a storage location for the library files (Figure 32).

Figure 31: When installing SCVMM, you must either install SQL Express (included with the SCVMM download) or 
use a SQL Server.
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Figure 32: SCVMM requires you to specify where the library should be placed.

SCVMM Server
A virtual machine running on Virtual Server consists of a configuration file (.vmc) and one or more data 
files. These data files can include virtual hard disks (.vhd files), other media files, such as images (.iso files) 
and virtual floppy disks (.vfd files). Only the .vhd file can be used by Hyper-V. All of the other files used 
by Virtual PC or Virtual Server are incompatible with Hyper-V.  Consider not converting virtual machines 
running operating systems that cannot take advantage of Hyper-V integration services.   

VM Library Server
The SCVMM library stores and catalogs the many large files generated by virtualization products, 
including the following:

•	 VHD files for inactive VMs.

•	 CD or DVD images (e.g., ISO files) used as alternatives to physical media for software distribution.

•	 Hardware profiles, which are hardware specifications for a specific VM and contain information 
such as CPU type, amount of memory, and the priority given to the VM when it is running.

•	 OS profiles, which provide the most common OS settings, such as the computer name and domain 
or workgroup settings. 
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SCVMM Admin Console
The SCVMM Administrator Console is the front end through which all management tasks are performed. 
Virtual machine and host management of Virtual Server 2005 R2, including 2008 release, Hyper-V hosts 
and V13 infrastructure and features (i.e., DRS, HA, intelligent placement, templates, etc.) is achieved 
through the System Center Virtual Machine Manager (SCVMM).  VMware’s VirtualCenter can be added 
and ESX hosts can be managed from within SCVMM. Virtual Machine Manager 2008 provides most 
VirtualCenter Server functionality including VMotion. 

Performance and Resource Optimization (PRO) can be integrated with other System Center products, 
such as: 

•	 System Center Data Protection Manger (SCDPM) helps create a backup plan for your VMs as well as 
continuous data protection.

•	 System Center Operations Manager (SCOM) replaces MOM as a health monitoring program for 
your physical and VMs.

•	 System Center Configuration Manager replaces SMS as a scripting and configuration program.

•	 PowerShell.

SCVMM Administrator Console Overview
Once the SCVMM Administrator Console has connected to a SCVMM Server instance the main user 
interface displays.  The console consists of a menu bar, toolbar and several different panes, dependent on 
the current view that is selected.    

SCVMM Administrator Console Views 
Console views are selected using the list in the bottom left hand corner of the window. The number of 
views available will depend on the current configuration of the SCVMM 2008 environment. The full list of 
views consists of the following: 

Hosts - Displays information and options relating to managed host systems. 
The first step in using SCVMM is to add a host which can be a Hyper-V, Virtual Server 2005 R2 or ESX host. 

1.	 Create a host group called HyperV by right-clicking All Hosts. 

2.	 Select New host group. 

3.	 Click on the Hosts button in the left pane. 

4.	 Click the Add Hosts link on the right. There will be an Add VMware VirtualCenter Server link.  

5.	 A new wizard will start. Specify a hostname. 

6.	 Add the host to the newly created HyperV hosts folder. 

The View Script button with the PowerShell icon is where all underlying PowerShell code is executed. 

Every task performed in SCVMM can be scripted in PowerShell.  

1.	 The host will be added to the SCVMM and all virtual machines currently running on it will be 
added to the SCVMM inventory. To view all virtual machines running on the host, click on the 
Virtual Machines link in the left pane.
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Figure 33: Selecting a host on an Active Directory network

2.	 The Hosts view can also be customized to see the guest status, CPU, RAM, Disk, and Network 
usage of each VM by selecting customizations from the View → Select Columns. Menu:

Figure 34: Customized Host tab columns displaying resource allocation and status

Other SCVMM Console Areas

The host will be added to the SCVMM and all virtual machines currently running on it will be added to the 
SCVMM inventory.  

Virtual Machines – displays information and options relating to the management all virtual machines 
installed on managed hosts (Figure 35).
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Figure 35: The Virtual Machines tab

Library – displays information and provides options relating to the management of SCVMM Library 
Servers and library shares. By default, 2 blank VHD disks are provided in the library.

The library allows you to add items such as ISO files, starter VHD s, and guest OS profiles to assist in the 
deployment of new VMs. The New Guest OS Profile screen allows you to specify options such as computer 
name, administrator password, time zone, product key, and domain. This makes the guest OS profile similar 
to a stripped down version of Sysprep, and can even include Sysprep.inf or Unattend.xml files.

The new hardware profile allows you to specify a common configuration for machines you deploy based 
on that configuration. For example, you could configure your virtual development servers to only have 
1 gigabyte of RAM, while new virtual production server could be allocated 4. You could be sure that all 
machines you deploy have like settings.

Jobs – displays information and provides options to manage jobs. Virtual machine state can be managed 
by: stopping, starting, pausing or saving states. Jobs are steps that are initiated whenever a change is 
made within SCVMM. Jobs can be audited and are run independently. SCVMM administrator console 
provides filters to drill down into specific result categories.  
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Figure 36: Running jobs in SCVMM display detailed statuses.

When you create a job in SCVMM, SCVMM generates the Powershell code that it will use behind the 
scenes to perform the task. Each wizard has a “View Script” button at the end of it, which will display the 
generated code in notepad.  Because of powershell’s verbose syntax, it is easy to read the scripts and 
modify them to automate Hyper-V operations. In the example code below, SCVMM creates a new virtual 
machine and places it on a host. It creates a virtual network adapter, DVD drive, and allocates a virtual CPU, 
before putting all these values into a hardware profile. Finally, it creates a VM called “Test VM 1” and places 
it on the “cluster20” host.

After a job is run in SCVMM, a summary screen is displayed (Figure 37) that shows what changes SCVMM 
made to a host, library, or virtual machine.

# --------------------------------------------------------------
# New Virtual Machine Script
# --------------------------------------------------------------
# Script generated on Monday, April 19, 2010 2:36:31 PM by Virtual Machine Manager
# 
# For additional help on cmdlet usage, type get-help <cmdlet name>
# --------------------------------------------------------------
New-VirtualNetworkAdapter -VMMServer localhost -JobGroup 80df38d6-7a75-4359-bb34-410bb125fa8b 
-PhysicalAddressType Dynamic -VirtualNetwork “Local Area Connection - Virtual Network” 
-VLanEnabled $false 
New-VirtualDVDDrive -VMMServer localhost -JobGroup 80df38d6-7a75-4359-bb34-410bb125fa8b -Bus 1 
-LUN 0 
$CPUType = Get-CPUType -VMMServer localhost | where {$_.Name -eq “1.20 GHz Athlon MP”}
New-HardwareProfile -VMMServer localhost -Owner “LAB\administrator” -CPUType $CPUType -Name 
“Profile7950ac93-53f3-46e1-a78a-5d783349b3ff” -Description “Profile used to create a VM/
Template” -CPUCount 1 -MemoryMB 512 -RelativeWeight 100 -HighlyAvailable $false -NumLock 
$false -BootOrder “CD”, “IdeHardDrive”, “PxeBoot”, “Floppy” -LimitCPUFunctionality $false 
-LimitCPUForMigration $false -JobGroup 80df38d6-7a75-4359-bb34-410bb125fa8b 
$VirtualHardDisk = Get-VirtualHardDisk -VMMServer localhost | where {$_.Location -eq “\\SCVMM.
lab.local\MSSCVMMLibrary\VHDs\Blank Disk - Small.vhd”} | where {$_.HostName -eq “SCVMM.lab.
local”}
New-VirtualDiskDrive -VMMServer localhost -IDE -Bus 0 -LUN 0 -JobGroup 80df38d6-7a75-4359-
bb34-410bb125fa8b -VirtualHardDisk $VirtualHardDisk -Filename “Test Machine 1_Blank Disk - 
Small.vhd” 
$VMHost = Get-VMHost -VMMServer localhost | where {$_.Name -eq “cluster20.lab.local”}
$HardwareProfile = Get-HardwareProfile -VMMServer localhost | where {$_.Name -eq 
“Profile7950ac93-53f3-46e1-a78a-5d783349b3ff”}
$OperatingSystem = Get-OperatingSystem -VMMServer localhost | where {$_.Name -eq “Windows 
Server 2003 Enterprise x64 Edition”}
New-VM -VMMServer localhost -Name “Test Machine 1” -Description “” -Owner “LAB\administrator” 
-VMHost $VMHost -Path “C:\ProgramData\Microsoft\Windows\Hyper-V” -HardwareProfile 
$HardwareProfile -JobGroup 80df38d6-7a75-4359-bb34-410bb125fa8b -RunAsynchronously 
-OperatingSystem $OperatingSystem -RunAsSystem -StartAction AlwaysAutoTurnOnVM -DelayStart 0 
-StopAction SaveVM 
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Figure 37: A detailed status is given of all values changed by a job.

Administration – provides a range of seven sub-options relating to the administration of the SCVMM 
2008 environment: 

•	 Overview – provides a graphical overview of the status of virtual machines, jobs,  
libraries and hosts. 

•	 General – access to SCVMM 2008 configuration such as database, library, remote control  
and placement (load balancing). 

•	 Managed Computers – perform tasks relating to managed hosts such as updating and removing 
SCVMM Agents. 

•	 Networking – manages the MAC address range used by SCVMM hosts. 

•	 User Roles – view and manage user roles to control access and permissions within the SCVMM 
infrastructure. For example, this view allows profiles to be configured to control which users have 
access to the Self-Service portal, and what they can do when they log into it. 

�� System Center – provides access to System Center OpsMgr reports.

�� Virtualization Managers – displays on all virtual machine managers (including both 
SCVMM and VMware managers) currently being managed.
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Figure 38: Administration View of the Seven Sub-Categories of SCVMM

•	 Reporting – provides reporting options when the Operations Manager has been configured. 

•	 Diagram – provides monitoring of entire SCVMM environment (hosts, virtual machines, SCVMM 
Server, SCVMM Library Servers etc). This view is only available when the Operations Manager has 
been implemented. 

SCVMM Self-Service Portal
The Virtual Machine Manager Self-Service Portal is a Web page through which self-service users can 
create and operate their own virtual machines within a controlled environment. In their sessions with the 
Self-Service Portal, self-service users see only the virtual machines that they own and the actions that 
their virtual machine permissions allow them to perform. With the SCVMM self-service portal feature, 
testers can set up and remove testing VMs as needed, without involving administrators.

The Self-Service Portal is installed by using a Setup wizard. 

1.	 Open the Start menu.

2.	 Point to All Programs. 

3.	 Point to Microsoft System Center Virtual Machine Manager 2007.

4.	 Click Virtual Machine Manager Self-Service Portal. 
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To open the SCVMM Self-Service Portal in a Web browser: 

1.	 In a Web browser, specify the portal Web site in one of the following formats:

a.	 If the Self-Service Portal Web site is using a dedicated port, type http:// followed by  
the computer name of the Web server, a colon, and then the port number. For example, 
http://WebServer:80.

b.	 If not, type http:// followed by the host header name.

2.	 To open the Web site, press ENTER.

Figure 39: SCVMM Self-Service Portal’s main screen. 
From here you can create, manage, and remove VMs and library items.

SQL Server Database 
The SQL Server Database approach provides a virtualized and manageable solution with greater 
consolidation and less expense. This includes a standard library of server builds and an approach for 
replacing the current manual build process of development, test, and production environments. Not all 
SQL Server instances are good candidates for consolidation. The SQL Utility targets the majority of online 
transaction processing (OLTP) databases.

Consolidation and virtualization of resources is provided by the Storage Utility area network 
(SAN) storage. The SQL Utility and consolidation effort builds on the foundations that the Storage Utility 
and Compute Utility strategies provide. These strategies focus on consolidation and virtualization of 
resources. Microsoft IT Applications requirements and RightSizing data determine whether a virtual or 
physical server is needed, and to track all application and hardware resources. 
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SQL Server Consolidation Approaches include: 

•	 Host consolidation – places additional SQL Server instances on each physical host. 

•	 Instance consolidation – hosting more databases on each SQL Server instance, resulting in fewer 
overall SQL Server instances. Concerns and challenge include: more databases and applications, 
tempDB, memory, and service accounts; operating system that is shared in this model can 
influence patches, scheduled downtime, upgrade schedules, etc. 

•	 Database consolidation – hosting more applications on each database. This consolidation can be 
achieved by using schemas, but doing so is not a cost-effective approach for consolidating existing 
databases and applications.

 
SQL Utility

•	 Standard guest templates can be used for initial builds.

•	 Guests can be moved to newer hosts as needed for isolation, load balancing, or EOL  
server replacements.

•	 Guests can be reconfigured down or up to the next standard environment or guest.

•	 Small, medium, and large standard guests on a single host.

•	 Microsoft System Center Virtual Machine Manager 2007 can be used for capacity management.

•	 Consolidation platform is consistent with other consolidation efforts (i.e., Web servers).

Using SCVMM to Create VMs
Use the VM Wizard to create a new machine from:

•	 An existing VM

•	 Template in the library

•	 Disk stored in the library

Clone VMs is also an option.

After Hyper-V has been installed, create a virtual machine and set up an operating system on  
the virtual machine.

1.	 Open Hyper-V Manager. 

2.	 Click Start.  

3.	 Point to Administrative Tools. 

4.	 Click Hyper-V Manager. 

5.	 From the Action pane, click New.

6.	 Click Virtual Machine. 

7.	 From the New Virtual Machine Wizard, click Next.

8.	 On the Specify Name and Location page, specify the virtual machine name and it  
will be stored.  

9.	 On the Memory page, specify enough memory to run the guest operating system to be used on 
the virtual machine.

10.	 On the Networking page, connect the network adapter to an existing virtual network if network 
connectivity is to be established at this point. 
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11.	 On the Connect Virtual Hard Disk page, specify a name, location, and size to create a virtual 
hard disk to install an operating system on it.

12.	 On the Installation Options page, choose the method for installing the operating system:  
Install an operating system from a boot CD/DVD-ROM, (physical media or an .iso image file). 

•	 Install an operating system from a boot floppy disk. 

•	 Install an operating system from a network-based installation server. To use this option, 
configure the virtual machine with a legacy network adapter connected to an external 
virtual network. The external virtual network must have access to the same network as the 
image server.

13.	 Click Finish.

P2V Conversion
The P2V conversion process captures an image of the source disk and modifies the operating system and 
drivers to make them compatible with the Hyper-V or Virtual Server  hardware.

Virtual-to-virtual (V2V) machine conversion is a read-only operation that does not delete or affect the 
original source virtual machine. V2V conversion can be accomplished directly from an ESX host, from the 
SCVMM library, or from a Windows or Network File System (NFS) share. 

System Center Virtual Machine Manager (SCVMM) allows conversion of existing physical computers into 
Hyper-V virtual machines through a process known as physical-to-virtual (P2V) conversion. P2V uses 
an automated wizard ideal for large-scale conversions that can be completed through the Windows 
PowerShell command line. SCVMM P2V does not recognize clusters. If a guest cluster is set up, SCVMM will 
treat the cluster as individual virtual machines.

During the P2V process, SCVMM automatically installs:

•	 An agent is installed

•	 Hardware configuration is captured

•	 An image is made

•	 A fix-up is applied

•	 VM is created

SCVMM uses the BITS (Background Intelligent Transfer Service) protocol for receiving P2V images and 
other data.

Online Conversion
Online conversion does not require a restart of the source computer. The online conversion process 
consists of:

•	 Installing the agent on the source computer

•	 Retrieving hardware configuration

•	 Imaging

•	 Fixing up

•	 Creating the virtual machine
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Intelligent Placement
Intelligent Placement is a capacity planning function. Performance data is collected from the VM 
and the host where the VM runs, including CPU, memory, disk, etc. This data is fed into the modeling 
module, and then given user-defined placement to generate a set of SCVMM host ratings, such as: host 
performance capability based on memory considerations, disk capacity, and existing load.  

Microsoft Assessment and Planning Toolkit
Microsoft Assessment and Planning (MAP) toolkit is an inventory, assessment, and reporting tool which 
assesses IT environments for various platform migrations and virtualization without the use of any 
software agents. It is not part of SCVMM, but a separate free download from Microsoft. You should at least 
be familiar with what MAP does for the exam.

The MAP toolkit provides:

•	 Quickly discovers clients, servers, and applications across the IT environment.

•	 Conducts conversion and virtualization assessments for IT projects.

•	 Auto-generates reports and proposals.

•	 Scales well to small businesses as well as large enterprises.

MAP monitors the environment to get a view of utilization over time. It gathers data on performance 
and usage and will ultimately use this data to report to you. The MAP Power Savings Calculator calculates 
potential power cost savings with Hyper-V prior to deployment. MAP will make a recommendation about 
which servers should be co-located on which hosts to optimize performance.

The following reports can be generated: 

•	 Server Consolidation Proposal – readiness assessments and recommends a list of underutilized 
servers for consolidation. 

•	 Server Consolidation Report – detailed inventory of network servers and the potential efficiency 
gained by consolidating them into fewer physical servers.

•	 Power Savings Calculator and Proposal – calculates the potential savings and benefits  
of virtualization. 

Domain 8: Managing Libraries and Checkpoints
SCVMM Library
The Virtual Machine Manager server contains a SCVMM library, which is a catalog of resources that can be 
used to create and configure virtual machines in SCVMM. The library contains files stored on library shares, 
and it can contain file-based resources such as:

•	 VHD files for VMs.

•	 CD or DVD images (e.g., ISO files) used as alternatives to physical media for software distribution.

•	 Hardware profiles, which are hardware specifications for a specific VM and contain information 
such as CPU type, amount of memory, and the priority given to the VM when it is running.

•	 Templates.

•	 OS profiles, which provide the most common OS settings, such as the computer name and domain 
or workgroup settings. 
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•	 Stored VMs.

•	 Scripts.

•	 Guest operating system profiles, which can be used to create virtual machines. 

When you add a library server, SCVMM automatically installs an agent on the library server.

The Virtual Machine Manager Library is a repository used to store a variety of virtual machine resources 
such as virtual hard disk and CD/DVD ISO images, virtual machine templates, stored virtual machines, 
virtual floppy disks, hardware and guest operating system profiles and SysPrep answer files. The primary 
purpose of the library is to promote re-use of information and objects in the creation and configuration of 
virtual machines deployed within the SCVMM infrastructure. 

A SCVMM Library consists of resources stored in one or more network share folders on the SCVMM 
Library Server system combined with information cataloged in the SQL Server database associated with 
the SCVMM 2008 installation. By default, the SCVMM Library share folder is located in %SystemRoot\
ProgramData\Virtual Machine Library Files and shared under the name MSSCVMMLibrary. 

A SCVMM 2008 configuration can have multiple SCVMM Library Servers configured. The Library Server 
is commonly installed on the same system as the SCVMM Server, although for larger mission critical 
configurations, it is recommended that the SCVMM Library Server be deployed on a failover cluster. 

Understanding Templates
The SCVMM has the ability to create a template or guest/hardware profile. There are two ways to create a 
Virtual Machine template:

1.	 Create a New Template – in the library, click the New Template link on the right side to  
launch the template wizard. Create a Virtual Machine that can be used as a template using the 
New Template Wizard. Select the source for the new template. In this example, select From an 
existing virtual machine currently located on a host. After configuring the hardware profile 
specify all OS relevant information such as product key, computer name, default password and 
domain joining rules. There is also where to insert a sysprep answer file, if desired. The new 
template will be ready for deployment and stored under VMs and Templates.

2.	 From existing VHD – create a template is from an existing VHD that is already stored in the 
Library.   Navigate to VMs and templates in the library view, right-click the template and select 
New Virtual Machine. A wizard will guide the process. 

Types of Library Resources
The SCVMM library is a catalog of resources you can use to create and configure virtual machines in 
SCVMM. The library contains:

•	 Files stored on library shares - This includes virtual hard disks, virtual floppy disks, ISO images,  
and scripts. To be used in SCVMM, file-based resources must be added to the library by storing  
the files on a library share of a library server. The SCVMM library initially contains a single,  
default library server and library share, and two blank .vhd files, which Setup creates on the 
SCVMM server. The SCVMM server always remains the default library server, and the default library 
server and library share cannot be deleted.  More library servers and shares can be added based on 
business needs and objectives. Library files and resources can also be distributed to branch offices 
or other remote locations. 
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•	 Operating system and hardware configurations – this includes virtual machine templates, 
hardware profiles, and guest operating system profiles, which can be used to create virtual 
machines that have uniform configurations. These configuration resources are stored in the 
SCVMM database and are not represented by physical files. 

•	 Virtual machine templates stored in the SCVMM database – virtual machines that are not in use 
can be stored in the library. Stored virtual machines are displayed in Library view; however, the 
files for a stored virtual machine are not indexed and displayed in Library view, because those files 
cannot be used to create or configure new virtual machines. 

Library resources are added, created, used, and managed in Library view.

Refreshing the Library
After adding files to a library share, the files do not appear in Library view until they are indexed by 
SCVMM during the next library refresh. Refresh the library share manually or wait until the next periodic 
library refresh.

Library Groups
As more library servers are added, library groups can be created. Coordinate library servers with the host 
groups that use their resources, especially when the library server is also connected to the SAN. This will 
tell which hosts and library servers are connected to the SAN to take advantage of faster file transfers on 
the SAN.

The library group Properties dialog box makes alignment easy by displaying the host groups in the Library 
group drop-down list. 

Hardware Profile Components 
1.	 Hardware resources can be manually allocated to use the hardware profile.

2.	 Click Next to be taken to the New Virtual Machine Wizard’s Select Destination screen.  
Select whether to place the new virtual machine on a host or to store the virtual machine in a 
library. In most cases, it is best to place the cloned machine in the library.  

3.	 What happens next really depends on the option that you select on this screen. If the  
server is placed in the library a prompt to enter the library server name and path displays.  
If hosting the virtual machine, specify the host and path and how the virtual machine will 
connect to the network.

SCVMM 2008 Pre-installation 

Connect to SCVMM website.  The SCVMM Configuration Analyzer scans computers to verify if they are 
suitable to function as a SCVMM Server, run the SCVMM Administrator console, function as a Self-Service 
Portal or be a Managed Host. Run the SCVMM Configuration Analyzer prior to actually beginning the 
setup process to examine the server that will be hosting the Virtual Machine Manager function. 
The SCVMM configuration Analyzer is not included with the product and must be downloaded from the 
Microsoft public download site.

First install the Microsoft Baseline Configuration Analyzer as a download on the Microsoft public download 
site. Run with an account that has administrative permissions to all machines that are being scanned. 
After the scan completes, a report is opened in Internet Explorer documenting the results of the scan.
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Installing Virtual Machine Manager Server
1.	 Select SCVMM Server under SETUP on the main screen. 

2.	 Accept the license. 

3.	 Join the Customer Experience Improvement Program (CEIP). 

4.	 Enter Product Registration information. 

5.	 Execute the Prerequisites Check and make sure it completes successfully. If not, correct the 
problems and re-run the check. 

6.	 Select an Installation location on the local machine. 

7.	 Configure SQL Server settings. 

8.	 Create a new library share on the SCVMM server or select a pre-configured share. As a ‘best 
practice’, you may want to consider using another volume on the SCVMM Server for better 
performance and storage capacity. 

9.	 After setup is complete, the default library cannot be removed or relocated. An existing share on 
the SCVMM Server can be used in place of the default location; however it must reside on the 
SCVMM Server. Additional Library Shares and Servers can be added in the future. 

10.	 Specify ports to support SCVMM communications and designate a domain account to use for 
the SCVMM Service Account (Default is to use local system). If the Self- Service portal is being 
hosted on the SCVMM server, Port 80 will already be taken by the Default Website. Either change 
the port in IIS Services Manager or set a different one for SCVMM communications. 

11.	 Specify Local system or a domain account to use for the SCVMM Service Account (Default is to 
use local system). 

12.	 Verify all the selections before selecting Install. If no issues, the install will complete. Check for 
Virtual Machine updates on the Microsoft website. 

Note: When the SCVMM server is installed, all accounts in the local Administrators security group are 
automatically added to the SCVMM Administrator user role. 

SCVMM Administration Console
It is recommended that the Virtual Machine Manager Administrator Console be installed on the same 
computer as the SCVMM server. Additional SCVMM Administrator Consoles can be installed on other 
computers to remotely access and manage the SCVMM server. When the SCVMM Administrator Console is 
installed, the Setup Wizard also installs Windows PowerShell - Virtual Machine Manager Command shell. 
To use the SCVMM reporting feature SCVMM Administrator Console must be installed on the same 
computer as the SCVMM server. 

Installation Steps: 
1.	 In the setup menu select Administrator Console. 

2.	 Accept the License Terms. 

3.	 Review customer Experience Improvement program (CEIP) information. 

4.	 Execute the Prerequisites Check and make sure it completes successfully. If not, correct the 
problems and re-run the check. 

5.	 Select an Installation location on the local machine. 

6.	 Verify the Port Assignment. The default port is 8100.

7.	 Verify all the selections before selecting Install. If no issues the install completes. Check for Virtual 
Machine updates on the Microsoft website. 
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By default, a shortcut to the SCVMM Administrator Console will be placed on the desktop. Double-click 
on the shortcut and verify the Administrator console does open. The first time the SCVMM Administrator 
Console is opened, the Connect to Server dialog box displays. In the Connect to Server dialog box, do one 
of the following: 

•	 If you installed the SCVMM Administrator Console on the same computer as the SCVMM server, 
click Connect to connect to the local SCVMM server (localhost) using the port that was assigned 
during the installation of the SCVMM server.

•	 If using the SCVMM Administrator Console to connect to the SCVMM server on a different 
computer, in the Server name box, type the name of the computer where the SCVMM server is 
installed, followed by a colon and the port that assigned during SCVMM server installation. 

Understanding Hardware Profiles
The Virtual Machine Manager library is a catalog that gives access to file-based resources (such as Sysprep 
scripts, ISO images, and virtual hard disks) that are stored on your library servers and to virtual machine 
templates, guest operating system profiles, and hardware profiles that reside in the SCVMM database. 
You can also store virtual machines in the library when they are not in use. 

Templates and Profiles
By creating a virtual machine template, a reference image for a virtual machine can be used repeatedly. 
Templates are metadata only and exist in the SCVMM database, not in the file system.

In Library view, virtual machines and templates appear in the VMs and Templates node under any 
library server that stores physical files that the virtual machines or templates reference. A single template 
might appear on multiple library servers if, for example, it used an ISO image on one library server and a 
VHD on another. 

All guest operation system profiles and hardware profiles appear in the Profiles node—the bottom node 
in the navigation pane.
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Figure 40: The SCVMM Library

Virtual Machine Configurable Virtual Hardware Settings 
A hardware profile can be created based on defaults or based on an existing hardware profile. If no 
changes are made, the Virtual Machine Manager creates a default hardware profile. 

Virtual Machine Hardware Profile Specifications include:

•	 Host CPU resources. 

•	 Host Memory.

•	 Built-in virtual floppy drive.

•	 Built-in virtual IDE device - virtual hard disks cannot be attached to a stand-alone hardware profile.

•	 One or more optional virtual SCSI adapters that can be added. Virtual hard drives can be  
attached to the virtual SCSI adapter n a virtual machine or on a template but not on a stand- 
alone hardware profile.

•	 One or more optional virtual network adapters can be added. 

•	 Priority settings. 
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Self-Service Portal is an optional component of SCVMM 2008 that allows users or server administrators 
to create and manage their own virtual machines using a web interface. The portal utilizes SCVMM 2008 
self-service user roles which determine or limit the scope of the users’ actions. The prerequisite software 
for installing the Self-Service Portal are:

•	 Windows Server 2008 x64 Standard, Enterprise, or Datacenter edition

•	 Windows Server 2003 (or R2) with SP2

•	 Internet Information Server (IIS)

Self-Service Portal hardware requirements are defined by the number of concurrent users that the portal 
will serve. Check for updates before attempting to install a Self-Service Portal. 

To install the Self-Service Profile, complete the following steps:

1.	 Install the Self-Service Portal. It is one of the options on the SCVMM installer.

2.	 Determine which Hyper-V hosts should be used with the Self-Service Portal to host  
virtual machines.

3.	 Create a host group and move all the Self-Service candidate Hyper-V hosts to that host group.

4.	 Create a Self-Service User Role.

The Self-Service portal can be installed on the SCVMM server or on a separate machine. In order to install 
the Self-Service portal a base operating system and IIS to host the web console are needed. 

Installing Virtual Machine Manager Server Component
Once you have the SCVMM Administrative Console component installed, proceed to installing the  
Self-Service Portal. 

1.	 Logon to the machine with domain administrator credentials.

2.	 Insert the SCVMM 2008 media and launch the setup.

3.	 From setup screen, click SCVMM Self-Service Portal. The SCVMM Setup will copy temporary 
files needed for installation and launch the installation wizard.

4.	 The installation files are copied to the server. 

5.	 License Terms screen displays; select I accept the terms of this agreement and click Next.

6.	 On the Prerequisites Check screen, verify that all of the prerequisites have been met  
and click Next.

7.	 On the Installation Location screen, verify the path is correct and click Next.

8.	 On the Web Server Settings screen, verify the SCVMM Server fully qualified domain name,  
modify the default ports for the Administrative console if required, modify the port for the self 
service console, and then press Next.

9.	 On the Summary of Settings Screen, review settings and press Install to being installation of  
Self-Service Portal component.

10.	 At the end of the installation, success or failure of the Self-Service Portal installation message is 
received. Review status, click Close.
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Determine the Hyper-V Hosts for Self Service
Hyper-V hosts are typically dedicated for self-service use. Select as many Hyper-V hosts as necessary for 
the number of virtual machines that will be used as self-service that will run concurrently. Use Self-Service 
advanced features such as VM templates to determine. For example, a VM template that is limited to 1GB 
of RAM and a quota that allows only 2 VMs per self-service user will help predict the number of users in 
the self-service role.

Building Host Group for Self Service
A Hyper-V host can only be a member of a single host group and a Self-Service Portal defines access by 
the assigned host group. If multiple self-service portals are to be grouped together in the host group 
hierarchy, create a host group called Self-Service, and then create the other host groups under Self-Service.

1.	 From the SCVMM console, click the Hosts option in the left hand pane.

2.	 In the navigation menu on the left hand pane, select All Hosts.

3.	 From the Actions menu, click Add Host Group.

4.	 Enter Self-Service for the new host group name and press Enter. 

5.	 Drag and drop the Hyper-V hosts that are to be Self-Service hosts into the Self-Service  
host group.

Creating the Self-Service User Role
By default users cannot access the Self-Service Portal. Users, including Domain Admins, must be granted 
permission. To access the Self-Service Portal a self-service user role must be created and users added as 
members of that role. 

1.	 Click the Administration button.

2.	 Click New User Role in the Actions menu to start the New Role Wizard.

3.	 In the General screen, type a User role name and Description, then select Self Service User in 
the profile list, press Next.

4.	 In the Add Members screen, click Add and then type the names of the users or groups you want 
to add to this role, press Next.

5.	 In the Scope screen, select the Host Groups on which users will deploy their virtual machines, 
press Next.

6.	 In the Virtual Machine Permissions screen, select the actions that you want to allow the 
members of this group to perform on virtual machines press Next.

7.	 In the Virtual Machine Creation Settings, Select the options the members of the self-service 
user will be allowed to perform. If desired, set a virtual machine quota to limit the number of 
virtual machines the users can deploy at one time, press Next.

8.	 In the Library Settings screen, select if self-service user group members will have access to a 
library share. If self-service users to store their virtual machines on a library share, the stored 
virtual machines do not count against any virtual machine quota that you set when allowing 
self-service users to create a virtual machine, press Next.

9.	 Review your choices and press Create to create the self-service user group.
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Once self-service user permission and option roles are defined, the members of the role can access the 
Self-Service Portal. If the self-service member is assigned owner of any virtual machine(s) these machines 
will appear in the list as virtual machines they can manage. If they have the right to create new virtual 
machines, the New Computer option will allow them to select from the assigned predefined templates. 

Managing Checkpoints
A checkpoint is a snapshot of a virtual machine at a specific point in time. Checkpoints are implemented 
using differencing disks and enable an administrator to roll the virtual machine back to its state at the 
moment the checkpoint was created. Checkpoints are portable; when a virtual machine is migrated from 
one virtual machine host to another, the checkpoints migrate along with the virtual machine. As many as 
64 checkpoints can be created for a virtual machine however they are not a replacement for backups. 
Each checkpoint saves the state of each virtual hard disk that is attached to a virtual machine and all 
of the hard disk’s contents, including application data files. Use the Recover action to restore a virtual 
machine to its state when a checkpoint was created. Merge the checkpoint to delete the associated files 
and recover disk space. 

Creating a Checkpoint 
Shut down the virtual machine or use a VM in a Stopped or Turned Off state. To avoid losing any data, 
ensure that the virtual machine is not in use and that no processes are running on the virtual machine. 

1.	 In Virtual Machines view, expand All Hosts in the navigation pane, and navigate to the host on 
which the virtual machine is deployed.

2.	 In the results pane, select the virtual machine and then, in the Actions pane, click New 
checkpoint.  If the virtual machine is running, SCVMM warns that the checkpoint operation will 
turn off or shut down the virtual machine and ask if you want to continue.

3.	 To continue, click Yes.

4.	 Under Checkpoint description, enter a description to add to the timestamp that identifies  
the checkpoint.

Managing Networks in SCVMM
Although the networks in our examples may seem trivial since only 1 NIC has been dedicated to Hyper-V, 
as more hosts, VMs, and adapters are added, the networks will become more complex and difficult to 
follow.  Diagramming a large Hyper-V cluster can be difficult, showing how each virtual network card 
connects to each virtual switch and then to the physical hardware. This can be exceptionally challenging 
if you have NICs dedicated to a DMZ, LAN, a Backup Network, an iSCSI Network, and Cluster Heartbeat 
network. The process can be further complicated by redundancy.

SCVMM provides a tool that can help you visualize, secure, and utilize your host server’s NICs. By selecting 
Networking from the View menu, SCVMM will generate a display of the Host’s VMs and their Virtual 
Networks (Figure 41). 
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Figure 41: SCVMM Visualizing virtual and guest network connections.

Domain 9: PowerShell and Backups
SCVMM and PowerShell
The Virtual Machine Manager server product includes the Windows PowerShell - Virtual Machine Manager 
command shell. The command shell is used to manage virtual machine hosts, library servers and virtual 
machines, at the command line or by using task-based scripting. 

Windows PowerShell built-in commands, called cmdlets, assist in managing computers from the command 
line. Providers allow easy access to data stores, such as the registry and certificate store, and PowerShell 
also includes a parser and a fully developed scripting language.

The SCVMM command shell includes the standard Windows PowerShell cmdlets, but also provides a 
specifically designed comprehensive set of cmdlets. Use standard Windows PowerShell cmdlets with 
SCVMM to create scripts. Windows PowerShell and the SCVMM command shell, supports programming 
functions such as variable assignment, looping, conditional statements, and flow control. The cmdlets 
perform all SCVMM actions which can be used individually or strung together for more complex tasks. 
This means that any task to be performed by using the SCVMM Administrator Console can also be 
performed at the command line or by creating a Windows PowerShell script.
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The SCVMM Administrator Console includes features to perform both methods: 

•	 Like Exchange 2007 and higher, the Summary page of each wizard contains a View Script button 
that displays the Windows PowerShell cmdlets that the wizard will use to configure the changes 
based on individual specifications. The cmdlets can also be copied to be used in creating Windows 
PowerShell scripts.

•	 If Windows PowerShell scripts are stored in the SCVMM library, you can view, edit, or run the script 
in Library view. 

PowerShell Overview
Windows PowerShell provides centralized management of physical and virtual infrastructures when that 
infrastructure is managed by SCVMM. Built on the .NET Framework, Windows PowerShell helps to control 
and automate the administration of Windows operating systems and applications that run on Windows. 
Windows PowerShell 1.0 includes the following features: 

•	 Standard cmdlets for performing common system administration tasks and using Windows 
Management Instrumentation. A cmdlet contains a verb-noun pair that is separated by a dash. 
The verb acts on a Windows PowerShell object (the noun). Most cmdlets are simple, but they are 
designed to work in combination with other cmdlets. For example, cmdlets that contain the Get 
verb retrieve data. Cmdlets that contain the Set verb specify or change data. 

•	 Task-based scripting language and support for existing scripts and command-line tools. 

•	 Common syntax and naming conventions provided data can be shared easily and the output from 
one cmdlet can be used as the input to another cmdlet without configuration changes.

•	 Operating system navigation is simplified with command-based navigation. For example,  
Active Directory objects can be enumerated and manipulated using Powershell.

•	 Backwards compatibility with cmd.exe and batch files. This means that Powershell can be used for 
manipulation of files and executing programs.

•	 Objects can be directly manipulated or sent to other tools or databases.

•	 Custom tools and utilities to administer software. 

Begin Learning PowerShell
Windows PowerShell contains the following resources:

•	 Getting Started – brief introduction and tutorial. To open it, click Start, All Programs,  
Windows PowerShell 1.0, and then click Getting Started.

•	 User Guide – detailed introduction, including real-world scripts and scenarios. 

•	 Get-Help cmdlet – Windows PowerShell cmdlet gives an overview of system cmdlets and 
providers. Start Windows PowerShell, and at the prompt, type: Get-Help. 

To learn about the Windows PowerShell scripting language and other concepts, read the “about” topics.  
To see a list of “about” topics, type: Get-Help about. 
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PowerShell Benefits

•	 Cmdlets allows performance of complex tasks with only a few words.

•	 Object-oriented commands allow rich objects from a text base.

•	 Integrates with Windows system by making calls into the Windows Registry, .NET Framework or 
WMI extensions.

•	 Certificate based scripting allows only secure scripts to run by default.

•	 Cross-Product Scripting.

SCVMM uses Windows Management Instrumentation (WMI) for cross-product scripting. A WMI interface 
provides programmatic access to a system so users can write command-line administration scripts and 
tools. The WMI interface also allows network administrators the ability to collect and set configuration 
details on a wide variety of hardware, operating system components and subsystems, and software. 
WMI does not consolidate the management data in a central location.

Enable Windows PowerShell Scripts to Run
When Windows PowerShell is started on a computer, the default security policy does not allow the 
running of scripts. The Windows PowerShell security policy for scripting is called an execution policy. 
The execution policy gives the option to run scripts in your environment or to include a digital signature. 
Windows PowerShell does not allow a script to be run by double-clinging its icon due to the risks involved 
in using this method.

The following execution policies govern scripting in Windows PowerShell:

•	 Restricted – permits interactive commands only (no scripts). This is the default.

•	 AllSigned – permits scripts, but requires a digital signature from a trusted publisher for all scripts 
and configuration files, including scripts that you write on the local computer.

•	 RemoteSigned – permits scripts, but requires a digital signature from a trusted publisher for all 
scripts and configuration files that are downloaded from the Internet, including e-mail. A digital 
signature is not required for scripts that you create on the local computer.

•	 Unrestricted – permits scripts, including unsigned scripts.

Because the default Windows PowerShell execution policy is Restricted, Windows PowerShell scripts 
cannot be run until a change to a less restrictive execution policy is made. The following Windows 
PowerShell Help topics explain execution policies. 

At the Command Prompt, enter:	

•	 Get-Help about_Signing – displays information about Windows PowerShell execution policies 
and the levels of security that the execution policies provide.

•	 Get-Help Get-ExecutionPolicy – displays information that explains how to determine the current 
scripting security policy.

•	 Get-Help Set-ExecutionPolicy – displays information that explains how to change scripting 
security policy.
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Creating Scripts
Windows PowerShell scripts are stored in the SCVMM library. They can be viewed, edited, and run 
in Library view. 

To run a script from the SCVMM Administrator Console, enable scripting in Windows PowerShell on the 
local computer using one of the methods from the previous section on changing the signing policy. 

To view or edit a Windows PowerShell script from the SCVMM library 

1.	 In Library view, select the script to be viewed.

2.	 In the Actions pane, under Script, click View PowerShell script to open the script in Notepad.

If Save As is used to save a new script on the same share, the script will be added to the library during the 
next library refresh. Give the file a .ps1 file name extension to enable running it in the Windows PowerShell 
– Virtual Machine Manager command shell. Use the Refresh share action to perform a manual refresh on 
the library share.

To run a Windows PowerShell script from the SCVMM library” 

1.	 In Library view, select the script to be run.

2.	 In the Actions pane, under Script, click Run PowerShell script to load the script in a Windows 
PowerShell runspace.

3.	 If an unsigned script, at the prompt, type R (Run Once).

Windows PowerShell Script Extensions
There are three script file extensions in Windows PowerShell, although most script files have 
the .ps1 extension. 

•	 Windows PowerShell Scripts have extension .ps1 – a standard Windows PowerShell script.

•	 Windows PowerShell Console Files have extension .psc1 – defines the configuration of a specific 
Windows PowerShell console. 

�� Microsoft System Center Virtual Machine Manager 2008\Bin\Cli.psc1 is the Windows 
PowerShell console file for Microsoft System Center Virtual Machine Manager.

�� Microsoft.EnterpriseManagement.OperationsManager.ClientShell.Console.psc1 is the 
Windows PowerShell console file for Microsoft System Center Operations Manager.

�� For more information about Windows PowerShell console files, type Get-Help Export-
Console at the command prompt.

•	 Windows PowerShell Format and Type definitions have file extension .ps1xml – a type of script 
file Windows PowerShell home directory (C:\WINDOWS\SysWOW64\Windowspowershell\v1.0). 

For more information, type Get-Help about_Types at the command prompt.
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Running Windows PowerShell Scripts
When running a Windows PowerShell script, indicate the full path with the name of the script even 
if working in the directory in which the script is located. The following methods can be used to run a 
Windows PowerShell script:

•	 Use the dot and the backslash (.\) to indicate the local directory, i.e.: .\ <ScriptName>.ps1

•	 Specify the full path of the script, i.e., C:\Scripts\<ScriptName>.ps1

•	 Specify the path of the script, omit the extension, i.e., C:\Scripts\<ScriptName>

•	 Use the Invoke-Expression cmdlet to run a script, i.e., Invoke-Expression C:\
Scripts\<ScriptName>.ps1

•	 Use double quotation marks for any paths that include spaces, i.e.,  
Invoke-Expression “C:\My Scripts\<ScriptName>.ps1”

•	 Use the ampersand to run a script. Example:  
& C:\Scripts\<ScriptName>.ps1

SCVMM PowerShell Examples
By default, Hyper-V does not include any cmdlets. The only cmdlets that run with Hyper-V are provided by 
SCVMM. SCVMM provides the following PowerShell namespaces:

•	 MSVM_VirtualSystemManagementService – create, import, export, snapshot, and delete  
virtual machines.

•	 MSVM_VirtualSwitchManagementService – allows you to control virtual networks.

•	 MSVM_ImageManagementService – allows you to create, mount, and manipulate VHD files.

In this section, we will show some examples of how PowerShell can be used to manage SCVMM and 
Hyper-V hosts.

Example 1: Use PowerShell to list the vitals of each virtual machine that SCVMM knows about. This is 
useful for inventorying Virtual Machines.

PS C:\Windows\system32> get-vm | select name, status, hostname, memory

Name                     Status HostName                          Memory
----                     ------ --------                          ------
SCVMM                    Running cluster20.lab.local                1024
Test Machine 1           PowerOff cluster20.lab.local                512

Example 2: Use PowerShell to create a checkpoint of a VM and restore to that checkpoint at a later time. 
This example might be useful for software testing teams who need to roll a test image back to a 
previous version.

PS C:\Windows\system32> $checks = get-vmcheckpoint -vm “Test VM 1”
PS C:\Windows\system32> restore-checkpoint -vmcheckpoint $checks

A checkpoint is the same thing as snapshot. Snapshots are used in Hyper-V without SCVMM, while SCVMM 
refers to them as Checkpoints. Just like a snapshot, restoring a checkpoint will turn off the virtual machine 
if it isn’t already.
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Backup and Recovery
The Windows Server Backup consists of a Microsoft Management Console (MMC) snap-in and command-
line tools that provides a complete solution for day-to-day backup and recovery needs. You can use four 
wizards to guide you through running backups and recoveries. Use Windows Server Backup to:

•	 Back up a full server (all volumes), selected volumes, or the system state. The backup can recover 
volumes, folders, files, certain applications, and the system state. 

•	 A system recovery will restore the complete system onto the new hard disk in case of a disaster.

•	 Use Windows Server Backup to create and manage backups for the local computer or  
a remote computer. 

•	 Use schedule backups to run automatically and perform one-time backups to augment the 
scheduled backups.

Windows Server Backup is available in all editions of Windows Server 2008 (both 32-bit and 
64-bit versions). The Windows Server Backup snap-in is not available for the Windows Server 2008 
Server Core installation option. With a Server Core installation, either use the command line or manage 
backups remotely from another computer. The Server Core installation option does not include Windows 
PowerShell, so the cmdlets for Windows Server Backup are also not available on this type of installation.

Windows Server Backup 
Install the Windows Server Backup, Command-line Tools, and Windows PowerShell items that are 
available in the Add Features Wizard in Server Manager. This installs the following tools:

•	 Windows Server Backup Microsoft Management Console (MMC) snap-in 

•	 Wbadmin command-line tool

•	 Windows Server Backup cmdlets (Windows PowerShell commands)

Installation of the Windows server Backup features in Service Manager must be performed by a member 
of the Backup Operators or Administrators group. Access the Windows Server Backup from Server 
Manager by clicking on the Storage node.

To install backup and recovery tools 

1.	 Click Start, click Server Manager.

2.	 In the left pane click Features, and then in the right pane click Add Features.  This opens the 
Add Features Wizard.

3.	 In the Add Features Wizard, on the Select Features page, expand Windows Server  
Backup Features, and then select the check boxes for Windows Server Backup and 
Command-line Tools. 

4.	 A message displays that Windows PowerShell is also required to be installed with these features. 

5.	 If only installing the snap-in and the Wbadmin command-line tool, expand Windows Server 
Backup Features, and then select the Windows Server Backup check box. In this case, 
Windows PowerShell is not required.

6.	 Click Add Required Features, and then click Next.

7.	 On the Confirm Installation Selections page, review the choices that you made, and then click 
Install. Any errors in installation will be noted on the Installation Results page.
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8.	 Then, to access these backup and recovery tools, do the following:

•	 Windows Server Backup snap-in: Click Start, click Administrative Tools, and then click 
Windows Server Backup.

•	 Access and vie	 w the syntax for Wbadmin: Click Start, right-click Command Prompt,  
and then click Run as administrator. At the prompt, type: wbadmin /?

•	 Instructions to access and view the Help for the Windows Server Backup cmdlets are  
located at GettingStarted.rtf at: C:\Windows\System32\WindowsPowerShell\v1.0\
Documents\[language].

Backup with Hyper-V
There are three ways to back up Hyper-V servers. First, you can run a backup from inside the guest OS, 
as if the guest server isn’t virtualized at all. The only caveat to this approach is not to schedule all of your 
backups at the same time, since backups can be disk and network intensive. 

The second way to backup Hyper-V is by backing up the parent partition, which provides a backup of all 
of the VHD and XML files that compose a child server. This is known as an online backup. When a Hyper-V 
backup program such as Windows Server Backup begins a job, it will do 2 things:

1.	 Ask the parent partition’s disk subsystem to perform a Volume SnapShot.

2.	 Ask the child partitions, by means of the integration services, to perform a Volume SnapShot.

The third method of backing up Hyper-V is to shut down all of the VMs, run the backup, and then restart 
them. Sometimes this is necessary if the VMs are not capable of running integration services and the guest 
OS is not enlightened. This is known as an offline backup.

Understanding Online and Offline Backups 
An online backup can be performed with no downtime on a running virtual machine when all of the 
following conditions are met: 

•	 Integration services are installed and the backup integration service has not been disabled.

•	 Disks that are being used by the virtual machine are configured within the guest operating system 
as NTFS-formatted basic disks. Virtual machines that use dynamic disks or the FAT32 file system 
prevent an online backup from being performed.

•	 Volume Shadow Copy Service is enabled on all volumes used by the virtual machine with a specific 
configuration. Each volume must have its own storage location for its shadow copies and that 
mapping must be available to the Hyper-V VSS writer. 

•	 If an online backup cannot be done, offline backup is necessary. This results in downtime. 
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Practice Questions

Chapter 1
1. 	 You have a physical server that accesses three devices through COM ports. The server uses  
	 COM1, COM2 and COM3 to access these devices. All three devices must be connected to the  
	 same server as the application requires direct access to all three devices. You’ve tested the  
	 system and you can access each device individually from within a Hyper-V guest VM. 
	 You want to use a Windows Server 2008 Standard x64 server as the Hyper-V host. Will you be  
	 able to run this application on a VM and access all three devices and why?  
	 Select the best answer.

�� A. No, because Hyper-V does not support applications that communicate with devices 
attached to COM ports.

�� B. No, because Hyper only supports two attached COM port devices.

�� C. No, because the Standard Edition does not support COM ports.

�� D. Yes, because Hyper-V VMs can support up to four COM ports.

2. 	 You are configuring Windows Server 2008 Server Core to run Hyper-V. Before you install Hyper-V,  
	 you want to join the server to a domain named AHJ.local. The domain administrator account has  
	 a password of Try8956. Which one of the following commands will join the server to the 
	 desired domain? Select the best answer.

�� A. Netdom join %computername% /domain:ahj.local/userD:Administrator /password:Try8956

�� B. Net domain /add /user:administrator /password:Try8956

�� C. Netdom /add /user:administrator /password:Try8956

�� D. Add-domain -cred:administrator -pass:password

3. 	 You are configuring a Hyper-V installation. You want to use a command line-based admin tool  
	 that provides a menu to ensure that items like the domain or workgroup, the computer name,  
	 the network settings and Windows Update settings are configured appropriately. You want to  
	 access the menu and enter option 7 to configure Remote Desktop. What command line  
	 command should you run to access the Hyper-V Configuration menu at the command prompt?  
	 Select the best answer.

�� A. Hvconfig.wsf

�� B. Hvconfig.cmd

�� C. Hvconfig.exe

�� D. Hypervcfg.wsf
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4. 	 You are planning a Windows Server 2008 cluster for Hyper-V. You have used parallel SCSI for  
	 clusters in the past and have the hardware to support this. You have a server with 2 dual-core  
	 2 GHz processors and 12 GB RAM. You have no additional storage hardware or software. Why can  
	 you not use this configuration for hyper-V single-site cluster?  Select the best answer.

�� A. Windows Server 2008 clustering does not support parallel SCSI

�� B. Windows Server 2008 requires at least a 2.3 GHz dual-core processor

�� C. Windows Server 2008 requires 16 GB of RAM to run Hyper-V

�� D. Hyper-v is not supported on systems with more than one physical processor

Chapter 2

1. 	 You are concerned about the performance on a Hyper-V host. Which of the following tools may  
	 be used to analyze the performance on the Windows Server 2008 host that runs Hyper-V?   
	 Choose all that apply.

��  A. Resource Monitor

��  B. Reliability and Monitor

��  C. Process Manager

��  D. Task Monitor

2. 	 You want to ensure that Hyper-V VM snapshots are stored on a separate physical disk from  
	 the VM VHDs. In Hyper-V Manager, how can you configure the snapshot default storage location?  
	 Select the best answer.

�� A. You cannot change the default snapshot location

�� B. In Hyper-V Manager, select the Snapshot File Location option in the Action pane and 
configure the default snapshot folder here

�� C. In Hyper-V Server Settings..., select the Default Storage Locations option and configure the 
default snapshot folder here

�� D. In Hyper-V Server Settings..., select the Snapshot File Location option and configure the 
default folder here

3. 	 You are running Hyper-V on a Windows Server 2008 Enterprise Edition server. You will  
	 configure VMs on an iSCSI LUN. The LUN will be accessed using a network standard adapter.  
	 Client machines will access the virtual machines through the network. The Hyper-V host  
	 currently has one network adapter. Seven clients will use wireless connections to the LAN.  
	 What should you do to enable the desired configuration?  Select the best answer. 

�� A. Create two virtual networks on the network adapter; one for the client access and one for 
the iSCSI LUN access

�� B. Install another network adapter for the iSCSI communication

�� C. Configure a single virtual network to be shared for client access and iSCSI access

�� D. Install a wireless adapter for client access
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4. 	 You want to use the RSAT tools from a Windows 7 client to access and manage a Windows Server  
	 2008 Server Core installation. When you try to connect, you receive timeout errors. You suspect  
	 a firewall problem. Which one of the following commands will configure a firewall exception,  
	 when run on the Server Core server, to allow the remote administration tools to work?  
	 Select the best answer.

�� A. Netsh advfirewall firewall set rule group=”Windows Management 
     Instrumentation (WMI)” new enable=yes

�� B. Netsh advfirewall firewall set rule group=”Windows Management 
    Instrumentation (WMI)” new enable=no

�� C. Netsh advfirewall firewall set rule group=”Remote Server 
     Administration Tools (RSAT)” new enable=yes

�� D. Netsh advfirewall firewall set rule group=”Remote Server 
     Administration Tools (RSAT)” new enable=no

Chapter 3

1. 	 You have migrated VMs from a Virtual Server 2005 server to a Hyper-V server. The VMs have  
	 saved stated. They saved states are not working. The original host server was an AMD-based  
	 system with 4 GB RAM. The new host server is an Intel-based system with 8 GB RAM. Why will the  
	 saved states not work? Select the best answer.

�� A. Because the new host has more memory

�� B. The new machine uses a processor that accesses memory differently

�� C. You cannot use saved states from a Virtual Server host on a Hyper-V host

�� D. The new host has too little memory; a Hyper-V host requires three times the memory of a 
Virtual Server host

2. 	 You are responsible for converting physical machines to virtual machines that will run  
	 on Hyper-V.  Which two of the following operating systems can only be converted to virtual  
	 machines from physical machines in offline mode using SCVMM? Choose two.

�� A. Windows 2000 Server with SP4

�� B. Windows XP with SP2

�� C. Windows 2000 Advanced Server with SP4

�� D. Windows Vista with SP1
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3. 	 You are creating virtual machines in Hyper-V on Windows Server 2008 Enterprise edition.  
	 Which of the following are features provided by Integration Services for guest operating systems  
	 that support Integration Services? Choose all that apply.

�� A. VHD access

�� B. Heartbeat

�� C. Operating System Shutdown

�� D. Tim Synchronization

4. 	 You are using SCVMM to create templates for virtual machines. You want to ensure that the  
	 templates allow each VM created from the template to be unique. Do you need to run Sysprep  
	 separately and why have you chosen your answer? Select the best answer.

�� A. No, because Sysprep is not used with virtual machines

�� B. No, because Sysprep is executed as part of the template generation process

�� C. Yes, because Sysprep will not be used automatically and it must be used to  
generalize the VM

�� D. No, because Sysprep functions are performed by a different process in SCVMM

5. 	 You are responsible for the management of more than 100 VMs in a Hyper-V environment.  
	 You use SCVMM to manage the VMs and hosts. One virtual machine, which uses a pass- 
	 through disk, is not allowing you to create snapshots. The VM has 2048 MB RAM and two  
	 virtual processors. It is running Windows Server 2008 Enterprise as the operating system and  
	 has Integration Services installed. Why can you not create snapshots for this VM?  
	 Select the best answer.

�� A. Because the VM must have 4096 MB RAM to create snapshots

�� B. Because snapshots can only me taken on VMs that have two virtual processors

�� C. Because the operating system is Windows Server 2008, which does not allow for snapshots

�� D. Because a pass-through disk is used

6. 	 You have created a VM on Hyper-V. The VM boots, using pass-through, from an iSCSI LUN.  
	 What steps were required to make this happen? Each correct answer provides part of the solution.  		
	 Choose all that apply.

�� A. Attach the iSCSI LUN to the parent partition on the Hyper-V host

�� B. Point the VM to the physical disk, which is the iSCSI LUN, attached to the parent partition

�� C. Use the NET USE command to map the LUN to a drive letter

�� D. Create a LUN in the shared iSCSI storage container
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7. 	 You are working with the SCVMM Library. You must generate VMs from the Library. Currently,  
	 you have the following items in the library for a specific VM template you wish to create:- 
	 A source VHD-A guest OS profile-An OS answer file-A hardware profile.  What else is needed to  
	 form a complete template?  Select the best answer.

�� A. A template object

�� B. A WIM image

�� C. A network profile

�� D. A Ghost image

Chapter 4

1. 	 You are monitoring Hyper-V hosts. You want to gather several performance counters as well  
	 as trace information. In the Reliability and Performance Monitor on Windows Server 2008,  
	 what kind of object should you create?  Select the best answer.

�� A. Counter Log

�� B. Data Collector Set

�� C. Profile Trace

�� D. Trace Log

2. 	 You are using the Reliability and Performance Monitor on Windows Server 2008 to monitor  
	 a Hyper-V host. You want to save the DCS report to an alternate location. What action should  
	 you take? Select the best answer.

�� A. Right-click on the DCS and select Properties. On the Directory tab, change the  
report location.

�� B. Right-click on the DCS and select Data Manager. Configure the report location here.

�� C. Right-click on the DCS and select Change Location.

�� D. Right-click on the DCS and select Redefine Location.

3.	  You work as the administrator of several Hyper-V hosts running on Windows Server 2008 and  
	 Windows Server 2008 R2 machines. You want to monitor the performance of the hard drives in  
	 the host. What tool is a MMC console snap-in that can show CPU, disk, network and memory  
	 resources consumed by each process running on the machine without the specification of  
	 performance counters? Select the best answer.

�� A. Performance Monitor

�� B. Reliability Monitor

�� C. CHKDSK

�� D. Resource Monitor
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4. 	 You are configuring a server for use as a Hyper-V host. The server will use direct  
	 attached storage. You can connect up to four SATA drives in the server hardware configuration  
	 you’ve selected. The server supports RAID configurations. The VMs running on the host will not  
	 be mission critical but should perform as quickly as possible when up and running. A few hours  
	 of down time is acceptable, but ultimate performance when up is a must. Backups will be  
	 performed nightly and the loss of a day’s changes is acceptable for all VMs. Which RAID level will  
	 you configure for the drives on which the VMs will be stored? Select the best answer.

�� A. RAID 0

�� B. RAID 1

�� C. RAID 5

�� D. RAID 2

5. 	 You are using VLANs with your virtual switches in Hyper-V. You want to use hardware offloading  
	 for packets that require VLAN tagging. What feature must be supported by the hardware NIC in  
	 the Hyper-V host?  Select the best answer.

�� A. NDIS_ENCAPSULATION_IEEE_802_3_P_AND_Q_IN_OOB

�� B. NDIS_ENCAPSULATION_IEEE_802_11_G_AND_R_IN_OOB

�� C. NDIS_ENCAPSULATION_IEEE_802_1_X_IN_OOB

�� D. NDIS_ENCAPSULATION_IEEE_802_2_P_AND_Q_IN_OOB

6. 	 You are running Hyper-V on Windows Server 2008. You are configuring a Windows 2000  
	 Server guest. You plan to install the Integration Services in the guest. What type of storage  
	 driver should you use for this machine and why? Select the best answer.

�� A. IDE because the Integration Services for Windows 2000 Server do not support SCSI

�� B. IDE because it always performs better than SCSI

�� C. SCSI because it always performs better than IDE

�� D. SCSI because the Integration Services for Windows 2000 Server do not support IDE

7. 	 You are attempting to install Windows Server 2008 in a VM running on Hyper-V. When you boot  
	 the VM it delays looking for something on the network and then fails to book. You have the  
	 Windows Server 2008 OS ISO file in a folder on the host hard disk. What should you do to begin  
	 the installation of Windows Server 2008? Choose two.

��  A. Set the VM to booth from a PXE server

��  B. Power on the VM

��  C. Attach the ISO as VHD

��  D. Attach the ISO as a CD/DVD for the VM
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8. 	 You are planning backups using Windows Server Backup (WSB) on Server 2008 and Server 2008  
	 R2 machines with the Hyper-V role installed. Which one of the following is not a valid backup  
	 target for WSB?  Select the best answer.

��  A. Tape drives

��  B. Network shares

��  C. Internal SATA drives

��  D. USB drives

9. 	 You have performed a recover of a Hyper-V server by using the following process:1-Reinstall 	  
	 the Windows Server operating system2-Configure all OS settings as they were3-Add the Hyper-V  
	 role4-Configure role settings as they were5-Perform a file-based restore of VMsThe VMs are  
	 not displayed in the Hyper-V Manager. What action must you take that will require the least  
	 amount of time?  Select the best answer.

��  A. Redo the restoration from the backup as an Application restore

��  B. You must apply SP2 before you can mount the VMs

��  C. You cannot restore the VMs no; it is impossible

��  D. Add the VMs back to the Hyper-V server using the VHD mount utility

10. 	 You are considering several iSCSI solutions. You will be using the iSCSI solution for storage of  
	 VMs with Hyper-V hosts. Which of the following are valid implementation methods for  
	 iSCSI targets?  Choose all that apply.

��  A. Built-in iSCSI targets in network adapters

��  B. Remote servers running iSCSI hosting services

��  C. Dedicated SANs designed for iSCSI offering

��  D. Cisco routers with IPv6 installed
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Answers & Explanations

Chapter 1 
1. Answer: B
Explanation A. Incorrect. Hyper-V does support applications that communicate with devices attached to 
COM ports.

Explanation B. Correct. You can only attach two COM devices at a time and it canno support three.

Explanation C. Incorrect. The Standard Edition does support COM ports, just as the Enterprise Edition, but 
they are both limited to two COM port devices.

Explanation D. Incorrect. Hyper-V VMs can support a maximum of 2 COM ports.

2. Answer: A
Explanation A. Correct. The netdom command can be used to add the machine to the domain from the 
command prompt.

Explanation B. Incorrect. No such net domain option is available.

Explanation C. Incorrect. This is not the proper syntax for the netdom command.

Explanation D. Incorrect. No such command line exists in Server core.

3. Answer: B
Explanation A. Incorrect. The hvconfig.cmd file is used instead.

Explanation B. Correct. The cmd file is effectively a batch file that allows you to navigate through essential 
configuration tasks.

Explanation C. Incorrect. Hvconfig is a cmd file and not an exe file.

Explanation D. Incorrect. The proper command is hvconfig.cmd.

4. Answer: A
Explanation A. Correct. While Windows Server 2003 supported parallel SCSI, Windows Server 2008 does 
not - and Hyper-V only works on Windows Server 2008 and later.

Explanation B. Incorrect. The 2 GHz processor would work fine.

Explanation C. Incorrect. You can install Hyper-V with just 1 GB of RAM, though you wouldn’t be able to 
effectively run VMs.

Explanation D. Incorrect. Multi-processor systems are actually preferred.
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Chapter 2

1. Answers: A, B
Explanation A. Correct. The Resource Monitor is new in Windows Server 2008 and shows extensive details 
related to system resource utilization.

Explanation B. Correct. in Windows Server 2008, the Performance tool has been renamed to Reliability 
and Performance Monitor.

Explanation C. Incorrect. No such named tool exists in Windows Server 2008 by default.

Explanation D. Incorrect. no such named tool exists in Windows Server 2008 by default.

2. Answer: D
Explanation A. Incorrect. You can change it in the Hyper-V Server Settings dialog.

Explanation B. Incorrect. The Snapshot File Location option is located in the Hyper-V Server Settings dialog.

Explanation C. Incorrect. No such option exists in the Hyper-V Server Settings dialog.

Explanation D. Correct. The Hyper-V Server Settings dialog is the key to most host-wide settings, 
including the default snapshot folder.

3. Answer: B
Explanation A. Incorrect. When using a standard NIC for iSCSI LUN access, you must use a dedicated NIC.

Explanation B. Correct. You must dedicate a NIC to iSCSI communications when using a standard NIC for 
access to the LUNs.

Explanation C. Incorrect. When using a standard NIC for iSCSI LUN access, you must use a dedicated NIC.

Explanation D. Incorrect. The wireless clients will access the network through an access points, but the data 
will then travel the wired network to the VMs.

4. Answer: A
Explanation A. Correct. You must configure the advfirewall module in NETSH to enable the firewall rules. 
You will allow WMI.

Explanation B. Incorrect. Enable should be set to yes in the command; otherwise, it is accurate.

Explanation C. Incorrect. WMI should be enabled as RSAT uses WMI.

Explanation D. Incorrect. WMI should be enabled as RSAT uses WMI.
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Chapter 3

1. Answer: B
Explanation A. Incorrect. The increase in memory is not an issue here. The issue is the different ways AMD 
processors use memory as opposed to Intel processors.

Explanation B. Correct. When you migrate saved states from an AMD machine to an Intel machine they 
will not work.

Explanation C. Incorrect. As long as the processor type is the same, you can use these saved states.

Explanation D. Incorrect. No such constraints are imposed.

2. Answers: A, C
Explanation A. Correct. As long as Windows 2000 Server has SP4 or later installed, it can be converted, but 
it must be converted in offline mode.

Explanation B. Incorrect. Windows XP can be converted in online mode.

Explanation C. Correct. SP4 must be installed, but if it is, Windows 2000 Advanced Server can be 
converted; however, only offline mode is allowed.

Explanation D. Incorrect. Windows Vista can be converted in online mode.

3. Answers: B, C, D
Explanation A. Incorrect. VHD access is provided for all VMs, whether Integration Services are installed  
or not.

Explanation B. Correct. The heartbeat feature allows the parent partition to query the guest partition and 
ensure that it is available for communications.

Explanation C. Correct. The operating system shutdown feature allows the parent partition to send 
requests to the VM to shutdown the guest operating system.

Explanation D. Correct. The time synchronization feature ensures that the VM time is
synchronized with the parent partition time.

4. Answer: B
Explanation A. Incorrect. Sysprep is used with virtual machines when creating VMs to be cloned in Hyper-V 
Manager. When creating templates in SCVMM, Sysprep is executed as part of the process automatically.

Explanation B. Correct. The SCVMM tool uses Sysprep automatically so you don’t have to use it manually.

Explanation C. Incorrect. Sysprep is used automatically when generating templates from within SCVMM.

Explanation D. Incorrect. SCVMM actually uses Sysprep automatically.
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5. Answer: D
Explanation A. Incorrect. The amount of memory is not a constraint for snapshot creation.

Explanation B. Incorrect. On virtual processor is sufficient for the creation of snapshots.

Explanation C. Incorrect. Snapshots can be created for VMs that run Windows Server 2008.

Explanation D. Correct. Only VHD-based VMs support snapshots. You cannot create a snapshot on a VM 
with a pass-through disk.

6. Answers: A, B, D
Explanation A. Correct. You must attach the iSCSI LUN to the parent partition first. This causes the LUN to 
appear as a local drive to the VM.

Explanation B. Correct. Now, that the iSCSI LUN is mapped to the parent partition, it looks like a physical 
disk to the VM.

Explanation C. Incorrect. The drive letter association would be taken care of with the iSCSI initiator.

Explanation D. Correct. The LUN must exists before you can add it to the parent partition.

7. Answer: A
Explanation A. Correct. The template object brings the VHD, OS profile, hardware profile and OS answer 
file together as an actual template.

Explanation B. Incorrect. Templates are not based on WIM images, but on VHDs.

Explanation C. Incorrect. The missing item is the template object itself.

Explanation D. Incorrect. Ghost images are not used in VM templates within SCVMM.

Chapter 4

1. Answer: B
Explanation A. Incorrect. Counter Logs were used in Windows Server 2003 R2 and earlier versions  
of Windows.

Explanation B. Correct. Windows Server 2008 and Windows Vista introduced the concept of the Data 
Collector Set (DCS). A DCS may contain Performance Counters as well as trace data.

Explanation C. Incorrect. No such object can be created in the Reliability and Performance Monitor.  
The SQL Server Profiler, which comes with SQL Server, can be used to create a Profile Trace.

Explanation D. Incorrect. No such object exists in the Reliability and Performance Monitor.
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2. Answer: A
Explanation A. Correct. The report location is configured on the Directory tab. The report file name is 
configured by right-clicking and selecting Data Manager.

Explanation B. Incorrect. In the Data Manager dialog, you can only configure the report name and not the 
report location.

Explanation C. Incorrect. No such option exists.

Explanation D. Incorrect. No such option exists.

3. Answer: D
Explanation A. Incorrect. The Performance Monitor requires the specification of counters.

Explanation B. Incorrect. The Reliability Monitor shows the historical reliability of the machine.

Explanation C. Incorrect. The CHKDSK command is used to validate the integrity of the disk drives.

Explanation D. Correct. The Resource Monitor can display the disk utilization for each process.

4. Answer: A
Explanation A. Correct. RAID 0 is striping without parity. It provides the best performance, however,  
data must be restored from a backup should one of the drives fail.

Explanation B. Incorrect. RAID 1 will provide fault tolerance but seldom a performance gain.   
RAID 1 is mirroring.

Explanation C. Incorrect. While RAID 5 provides a nice balance between performance and reliability,  
the question demands only performance. RAID 5 is strip sets with parity.

Explanation D. Incorrect. RAID 2 is rarely supported by RAID controllers.

5. Answer: A
Explanation A. Correct. The 802.3p and 802.3q encapsulation ensures the NIC support VLAN tagging.

Explanation B. Incorrect. 802.11 is a wireless standard and not a VLAN standard.

Explanation C. Incorrect. 802.1X is a port-based authentication solution for networking and not  
a VLAN standard.

Explanation D. Incorrect. No such standard as 802.2p or 802.2q exists for Token Ring networks.
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6. Answer: A
Explanation A. Correct. The SCSI storage driver is not supported in the Windows 2000 Server version of 
the Integration Services.

Explanation B. Incorrect. SCSI performs better than IDE on the guest VMs that support it.

Explanation C. Incorrect. While SCSI does perform better on guest VMs that support it, Window 2000 
Server does not support the SCSI storage driver.

Explanation D. Incorrect. The opposite is true in that Windows 2000 Server supports IDE, but not SCSI.

7. Answers: B, D
Explanation A. Incorrect. It is already doing this.

Explanation B. Correct. Once the ISO is mounted, you should power on the VM to booth from the ISO  
as a CD/DVD.

Explanation C. Incorrect. ISO files are not supported as VHDs.

Explanation D. Correct. You can mount or attach the ISO as a CD/DVD and then boot from the image.

8. Answer: A
Explanation A. Correct. WSB no longer supported tape drives as of Windows Server 2008.

Explanation B. Incorrect. WSB can backup to a network share.

Explanation C. Incorrect. WSB can backup to internal SATA drives.

Explanation D. Incorrect. WSB can backup to USB drives.

9. Answer: D
Explanation A. Incorrect. While this action would work, it would take more time.

Explanation B. Incorrect. SP2 is not required.

Explanation C. Incorrect. You can mount the VMs to the Hyper-V server.

Explanation D. Correct. The VHD mount utility can be used to add the VMs back. You can also create new 
VMs with the proper configuration and point them to the restored VHD files.

10. Answers: B, C
Explanation A. Incorrect. Network adapters cannot act as iSCSI targets as they have no storage space.

Explanation B. Correct. You can get iSCSI server software for Linux and Windows machines so that the 
servers can act as iSCSI targets.

Explanation C. Correct. iSCSI SANs are hardware and software based solutions that act as iSCSI targets.

Explanation D. Incorrect. Cisco routers do not currently act as iSCSI targets regardless of the version  
of IP installed.

http://www.preplogic.com/products/video/view-video-training.aspx
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